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WARNING

To prevent fire or shock hazard, do
not expose the unit to rain or
moisture.

To avoid electrical shock, do not open
the cabinet. Refer servicing to
qualified personnel only.

ATTENTION

Pictures and/or Sound distortion may occur if
this product is positioned in close proximity to
equipment emitting electromagnetic radiation.

ATTENTION

Sony shall assume no responsibility for any
accidental or consequential damages or loss
of the recording contents which may be
caused by use or malfunction of the printer,
“Memory Stick” or PC card.

Owner’s Record

The model and serial numbers are located
on the bottom. Record the serial number
in the space provided below. Refer to this
number whenever you call upon your
Sony dealer regarding this product.
Model No. DPP-EX7

Serial No.

WARNING

This unit has no power switch.

When installing the unit, incorporate a
readily accessible disconnect device in the
fixed wiring, or connect the power cord to
socket-outlet which must be provided near
the unit and easily accessible. If a fault should
occur during operation of the unit, operate
the disconnect device to switch the power
supply off, or disconnect the power cord.
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For the customers in the U.S.A.
WARNING

This equipment has been tested and found to
comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable
protection against harmful interference in a
residential installation. This equipment
generates, uses, and can radiate radio frequency
energy and, if not installed and used in
accordance with the instructions, may cause
harmful interference to radio communications.
However, there is no guarantee that interference
will not occur in a particular installation. If this
equipment does cause harmful interference to
radio or television reception, which can be
determined by turning the equipment off and on,
the user is encouraged to try to correct the
interference by one or more of the following
measures:

— Reorient or relocate the receiving antenna.

— Increase the separation between the
equipment and receiver.

— Connect the equipment into an outlet on a
circuit different from that to which the
receiver is connected.

— Consult the dealer or an experienced radio/
TV technician for help.

You are cautioned that any changes or
modifications not expressly approved in this
manual could void your authority to operate this
equipment.

The shielded interface cable recommended in
this manual must be used with this
equipment in order to comply with the limits
for a digital device pursuant to Subpart B of
Part 15 of Fcc Rules.

If you have any questions about this product, you
may contact:

Sony’s Customer Information Services Center
(CISC) at 1-866-328-SONY (7669)

or Sony Web site at www.sony.com



Declaration of Conformity

Trade Name: SONY

Model No.:  DPP-EX7

Responsible Party:

Sony Electronics Inc.

680 Kinderkamarck Road,
Oradell NJ 07649 U.S.A.
Telephone No.: 201-930-6972

This device complies with part 15 of the
FCC Rules. Operation is subject to the
following two conditions:

(1) this device may not cause harmful
interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Address:

CAUTION

The nameplate is located on the bottom
enclosure.

Duplication, edition, or printing of a CD,
TV programs, copyrighted materials such
as pictures or publications, or any other
materials except for your own recording or
creation is limited to private or domestic
use only. Unless you hold copyright or
have permission of copyright holders for
the materials to be duplicated, use of those
materials beyond this limit may infringe
the provisions of the copyright law and be
subject to the copyright holder’s claim for
damages.

When using photo images with this
printer, pay special attention not to
infringe the provisions of the copyright
law. Any unauthorized use or
modification of others’ portrait may also
infringe their rights.

For some demonstrations, performances,
or exhibits, photography may be
forbidden.

Backup recommendations

To avoid potential risk of data loss caused
by accidental operation or malfunction of
the printer, we recommend that you save a
backup copy of your data.

Information

IN NO EVENT SHALL SELLER BE LIABLE
FOR ANY DIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES OF ANY
NATURE, OR LOSSES OR EXPENSES
RESULTING FROM ANY DEFECTIVE
PRODUCT OR THE USE OF ANY
PRODUCT.

® Microsoft, MS, MS-DOS and Windows®
are registered trademarks of Microsoft
Corporation in the United States and
other countries.

*IBM and PC/AT are registered
trademarks of International Business
Machines Corporation.

* MMX and Pentium are registered
trademarks of Intel Corporation.

* Apple, Macintosh, Power Macintosh,
and Mac OS are registered trademarks of
Apple Computer, Inc.

*“Memory Stick”, “2= ”, “Memory Stick
PRO” and “MagicGate Memory Stick”
are trademarks of Sony Corporation.

* “MagicGate” is the trademark of Sony
Corporation.

* This printer uses Exif Print (Exif 2.2)
technology.

¢ All other companies and product names
mentioned herein may be the
trademarks or registered trademarks of
their respective companies. Furthermore,
“T™M” and “®” are not mentioned in each
case in this manual.
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Notice for users

Program © 2002 Sony Corporation
Documentation ©2002 Sony Corporation

All rights reserved. This manual or the software
described herein, in whole or in part, may not
be reproduced, translated or reduced to any
machine readable form without prior written
approval from Sony Corporation.

IN NO EVENT SHALL SONY CORPORATION
BE LIABLE FOR ANY INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES,
WHETHER BASED ON TORT, CONTACT, OR
OTHERWISE, ARISING OUT OF OR IN
CONNECTION WITH THIS MANUAL, THE
SOFTWARE OR OTHER INFORMATION
CONTAINED HEREIN OR THE USE THEREOF.

By breaking the seal of the envelope of the CD-
ROM package, you accept all the terms and
conditions of this agreement. If you do not
accept these terms and conditions, please
return this disk envelope unopened, along with
the rest of the package, immediately to the
dealer where you obtained it.

Sony Corporation reserves the right to make
any modification to this manual or the
information contained herein at any time
without notice.

The software described herein may also be
governed by the terms of a separate user license
agreement.

User Registration

To receive customer services, complete and
return the registration card included in your
package.

Any design data such as sample pictures
provided in this software cannot be modified or
duplicated except for the purpose of personal
use. Any unauthorized duplication of this
software is prohibited under copyright law.
Please note that unauthorized duplication or
modification of others’ portraits or copyrighted
work could infringe the rights reserved by right
holders.
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Getting started

Features

Photo-realistic printing
With its dye sublimation printing system, the digital photo printer DPP-EX7
can make photo-realistic prints meeting a number of different requirements.

Super Coat 2 feature
The Super Coat 2 enables high durability and moisture or fingerprint
resistance, keeping your prints in good picture quality for an extended
period of time.

Auto Fine Print 2 feature (page 58)

The Auto Fine Print 2 analyses the picture information of an image and
corrects it as vivid, clear, and natural picture.

Exif 2.2* (Exif Print) support (page 58) Exif Print
The printer supports Exif 2.2. When the Auto Fine Print 2 is effective, the
printer automatically adjusts an image saved by a digital still camera
compatible with the Exif Print standard and then print it with optimal
picture quality (for JPEG files only).

Easy stylus operations on the color LCD screen
With the color touch-sensitive LCD screen, you can easily perform the
operations with the touch of a stylus and preview the images to be printed.
To select an image or an item, just tap the screen lightly with the stylus
supplied with your printer. A series of screen-activated operations will
navigate you though the printing process.

Selection of print sizes and border/borderless print

You can select from a large, dynamic Post Card (4 x 6 inch) size, 3.5 x 5 inch
size print or an economical Small (3.5 x 4 inch) size print. For the Post Card
(4 x 6 inch) size and 3.5 x 5 inch size prints, you can also select a print with or
without border.

Selection of print finish (page 59)

You can select the print finish from either glossy or texture.

* Exif (Exchangeable image file format for digital still cameras) Print is a global
standard for digital photo printing. A digital still camera supporting Exif Print
stores the data relevant to the conditions of shooting as each shot is taken. The
printer utilises the Exif Print data stored in each image file to ensure the printed
result matches the original shot as closely as possible.
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Paper tray allowing bulk printing of 25/30 sheets (page 20)
With the supplied paper tray, you can print up to 25 sheets for Post Card (4 x
6 inch) size and 30 sheets for 3.5 x 5 inch size and Small (3.5 x 4 inch) size
print paper at one time.

A wide variety of image processing and adjustments without
using a computer (page 30)
A variety of image processing functions allow you to magnify/reduce, rotate,
or move the image. You can also enter and overlay characters on an image or
add a special effect to the picture to produce sepia, monochrome, or paint
pictures. Adjustments of brightness, hue, and other elements of picture
quality are possible.

A wider variety of prints of “Memory Stick” or PC card images
without using a computer

You can view the digital still camera images stored in a “Memory Stick”
or PC card on the LCD screen without using your computer.

You can print an image placed with the cursor. You can also select
multiple images with specifying the print quantity (page 23).

All the contained images or all the DPOF (Digital Print Order Format)
preset images can be printed at one time (page 28).

You can print an image with the recorded or saved date (page 59). You
can also enjoy a slide show of the images (page 63).

The Creative Print menu allows you to make even more types of prints
such as an original card, calendar, split images, a sticker with framed
images, and an index print of the images stored in a “Memory Stick” or
PC card (page 36). With the Tool function, you can paste characters,
messages, stamps, or drawings onto an image.

For the “Memory Stick”, see page 86. For the PC card, see page 89.

Printing from your computer with a convenient USB connection
(page 66)
By connecting the printer and your computer with the USB cable supplied
and installing the supplied DPP-EX7 printer driver software on your
computer, you can print images from your computer.

7GB
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Unpacking the printer

Make sure that the following accessories are supplied with your printer.

e AC power cord (1)

e CD-ROM (1)

-Sony DPP-EX5/EX7 Printer
Driver Software
for Windows® 98/98SE/
Me /2000 Professional /XP
Home Edition/XP
Professional
for MAC 0S 8.6/9.0/9.1/

e Stylus (1) 9.2/X (v10.1/v10.2)

—Operating Instructions

e Cleaning kit (a set of cleaning paper and cartridge) (1)
® Operating Instructions (1)

* Warranty (1)

* Owner registration card (1)

¢ Sony End User Software License Agreement (1)

® The AC power cord illustrated is for 120V only. The plug shape and specifications
change depending on the region you use the printer.

* Never insert the CD-ROM supplied with the printer into a CD player or other audio
player, which may cause serious damage to your ears, speaker system, or
earphones, or malfunctions to the audio device.
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Identifying the parts

For details, see the pages indicated in
the parentheses.

Printer front panel

Operation panel cover

[2] POWER button (pages 18, 23, 25,
23)

“MEMORY STICK" insertion slot
(page 14)

[4] PC CARD insertion slot (page 15)

(5] PC card eject button (page 15)

[6] Paper tray compartment lid (page
21)

Cartridge compartment lid (page
18)

Print cartridge eject lever (page
18)

[9] Print cartridge (pages 17, 18)
(Not supplied)

Operation panel (pages 12)

INPUT SELECT button (page 23)

Switches the input. (The selected input
indicator [19] lights.)

ALL/DPOF button (page 28)
Each time you press the button, the
printing mode switches: ALL (printing
all the images » DPOF (printing all the
images with the print mark)  normal
printing mode

Stylus/stylus slot (page 12)

PRINT button (pages 24, 26)

“MEMORY STICK"”/PC CARD/PC
input indicators (pages 16, 23)

[ Paper error indicator (pages 22,
92)

&y Cartridge error indicator (page
18)

Continued
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Identifying the parts

‘IOGB

Printer rear panel
[1] USB connector (page 16)

Connects to the USB connector of your
computer.

[2] AC IN connector (page 15)
Ventilation holes

Paper tray
[1] lid (page 20)
[2] Partition (page 20)

[3] 3.5 x 5 inch paper adaptor (page
20)
Use the adaptor only when you feed 3.5 x
5 inch size paper into the paper tray.



Image list Screen

f

Cursor (orange frame)
“Memory Stick”/PC Card/Printer
images indication
Indicates that the source of the images
being displayed.
! Selection (yellow background)
: [4] Print mark (DPOF indication)
il . Indicates that the image is DPOF preset
ol
LUIZ00] ET@ for printing from a digital still camera.
(5] The quantity of selected images/
the total image quantity
When no image is selected, only the total
image quantity is displayed.

paypels buiren I

B Selectell Images : 0003/0135

The displayed quantity may differ from
the number of images actually saved on
a “Memory Stick” or PC card.
[6] Print cartridge indication
Indicates the type of print cartridge
currently loaded:
[ ]: Post Card (4 x 6 inch) size

:3.5 x 5 inch size
[IE] : Small (3.5 x 4 inch) size

Scroll bar

Indicates the position of the image
currently displayed or selected among the
total number of images.

Protect indication
Indicates that the image is protected by a
digital still camera.

[9] Image number

Print quantity indication
Operation buttons

[12] Guidance message
Scroll buttons

Image List button

Returns to the image list.

Preview image

‘|’|GB



Using the stylus and operation panel

Most operations on the DPP-EX7 are carried out by tapping an item or button
on the touchscreen of the operation panel. This section explains how to use
the stylus and touchscreen.

Note on the LCD screen

The LCD is manufactured using high-precision technology. You may, however, see
brighter points or color shifts on the LCD depending on the viewing angle. This is a
normal result of the manufacturing process and does not indicate a malfunction.

Opening the operation panel

’IZGB

Open the operation panel cover.

You can rotate the operation panel up to 180
degrees. Use the panel at an appropriate
angle such that you can view the screen
clearly and can perform the stylus operations
easily.

After you finish

* To keep the touchscreen safe and clean, we recommend you close the operation
panel after you finish using your printer.

 Keep the stylus in the slot on the panel to prevent it from being lost.

o If the screen becomes soiled, wipe it with a soft dry cloth such as a cloth used to
clean your eyeglasses.



Using the stylus

Press lightly on the button, image or item on the operation panel
screen using the point of the supplied stylus.

This action is referred to as “tapping” in this manual. Tapping allows you to
execute the button function or select an item or image on the screen.

Move the stylus while pressing on an image or item on the
operation panel screen using the point of the supplied stylus.
This action is referred to as “dragging” in this manual. Dragging allows you
to move an image or item or draw a line on the screen.

* Always use the point of the supplied stylus for tapping the screen. Never use a real
pen, pencil, or other sharp object to write on the screen.
¢ In case you lost the supplied stylus, contact Sony service facilities.

1368

pawels bunian



Connecting the printer

Inserting a “Memory Stick” or PC card

Notes

* Do not attempt to force a “Memory Stick” or a PC card into or out of the slot. If
you do, the “Memory Stick” or the PC card or the printer may be damaged.

® When the printer is accessing the “Memory Stick” or PC card and the relevant
indicator flashes, do not remove the “Memory Stick” or PC card from the printer.
If you do, the “Memory Stick” or the PC card or the printer may be damaged.

Inserting a “Memory Stick”
Insert the “Memory Stick” into the “MEMORY STICK” insertion slot until it
clicks into place.

“Memory Stick”

With the notch facing left and the arrow
facing forward on the left

To eject the “Memory Stick”
Push the “Memory Stick” further into the insertion slot and let it pop out.
Then remove it slowly.

Notes

e Insert the “Memory Stick” only. Do not insert any other objects.
e For the “Memory Stick”, see page 86.

14 6



Inserting a PC card
Insert the PC card into the PC CARD insertion slot until it clicks into place.

W PC CARD eject button
=)

PC card

To eject the PC card
Press the PC CARD eject button. After it pops out, remove it slowly.

e Insert the PC card only. Do not insert any other objects.
® For the PC card, see page 89.

Connecting the AC power cord

Connect the supplied AC power cord to the AC IN connector of the printer
and then to an AC outlet.
The POWER indicator lights in red.

Ve

To the wall
outlet

P

AC power cord
(supplied)

.

Continued
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[1] Connecting the printer

Connecting to a computer (optional)

16GB

Connect the USB connectors of the printer and your computer (Windows PC
or Macintosh) with a commercially available USB cable. By installing the
supplied driver software on your computer, you can print an image from your
computer. For details on how to install and operate the software, see
“Printing from your computer” (pages 66-83).

Windows/Macintosh
computer

<
To USB connector

To USB connector (B TYPE)

Use a commercially available A-B TYPE USB cable of shorter than 3m in length. The
type of a USB cable you should use may change depending on the computer. For
details, see the instructions manual of your computer.

When you connect a computer that is already powered on to the USB
connector of the printer

The PC input indicator lights and the printer enters the PC mode.

MEMORY PC

STICK CARD_ \PC/
é’
T\

*Do not remove or connect the USB cable into or from the printer during the data
communication or printing. The printer may not work properly.

¢ During the PC mode, no pictures are displayed on the LCD screen. This is not due
to trouble with the printer.

e Refer to the instruction manual of your computer for further information.

* You cannot use the printer and the printer driver on a network or with a
commercially available printer buffer.



[2] Preparing the printing pack

You need an optional printing pack designed for the printer. The pack contains
a set of print paper and a print cartridge for either Post Card (4 x 6 inch) size,
3.5 x5 inch size, or Small (3.5 x 4 inch) size prints.

Select the printing pack according to the type of printing you intend to do:

Printing pack

Contents

SVM-25LS 25 sheets of Post Card (4 x 6 inch) size photo paper/Print
cartridge for 25 prints

SVM-25LW 25 sheets of Post Card (4 x 6 inch) size sticker/Print
cartridge for 25 prints

SVM-30MS 30 sheets of 3.5 x 5 inch size photo paper/Print cartridge for
30 prints

SVM-30SS 30 sheets of Small (3.5 x 4 inch) size photo paper/Print
cartridge for 30 prints

SVM-30SW 30 sheets of Small (3.5 x 4 inch) size stickers/Print cartridge
for 30 prints

SVM-30SW09 30 sheets of Small (3.5 x 4 inch) size 9-split stickers/Print

cartridge for 30 prints

* To avoid a paper jam or malfunction and to obtain proper printed performances,
note the following:
- Do not rewind the ink ribbon and use the rewound print cartridge for
printing. Otherwise, proper printing result will not be obtained, or even a
breakdown may occur.

— Use the printing pack for this printer only.

— Always use the print cartridge designed for the size of the print paper you use.
Do not mix cartridges and paper of different types or sizes.

— Do not print on the used print paper. Printing an image twice on the same paper
will not make the printed image thicker.

— Do not remove the backing from sticker print paper before printing.

e For handling and storing the printing pack, not the following:

— Do not touch the ink ribbon of the print cartridge or the printing surface of the
print paper. Avoid placing the printing pack in locations that are subject to high
temperature, high humidity, excessive dust, or direct sunlight. If there are
fingerprints or dust on the printing surface or the ink ribbon, the printing quality
may deteriorate.

— When storing a partially-used pack of the print cartridge and print paper, store it
in its original bag or in a similar container.

‘]7GB
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Loading the print cartridge

1 Press the POWER button to turn on the printer.
The POWER indicator lights in green.

2 Pull and open the cartridge compartment lid.

oz o POWER

3 Insert the print cartridge into the printer firmly until it clicks
into place and close the cartridge compartment lid.

The side with the Sony logo

To replace the print cartridge
When the print cartridge runs out, the & cartridge error indicator lights and
an error message appears on the screen.

Open the cartridge compartment lid, push up the eject lever, remove the used
print cartridge, and then insert a new cartridge.

&y cartridge error indicator
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* Never put your hand into the cartridge compartment.
The thermal head reaches high temperatures,
especially after repeated printing.

* Do not rewind the ink ribbon and use the rewound print cartridge for printing.
Otherwise, proper printing result will not be obtained, or even a breakdown may

occur.
o If the print cartridge does not click into place, remove it and then re-insert it. If the
ink ribbon is too slack to be loaded, wind the ink ribbon in the direction of the

arrow to remove the slack.

o If the print cartridge is not loaded when you turn on the printer, the & cartridge
error indicator lights up.

* Do not touch the ink ribbon or place the print cartridge in a dusty location.
Fingerprints or dust on the ink ribbon may result in imperfect printing.

*Do not change the print cartridge while printing.

Notes on storing the print cartridge

* Avoid placing the print cartridge in a location subject to high temperatures, high
humidity, excessive dust or direct sunlight
* When you are going to store a partially-used cartridge, store it in its original bag.

‘]9GB
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(4] Inserting the print paper

1 Open the paper tray lid and set the 3.5 x 5 inch paper adaptor
and the partition according to the print paper size you want to
use.

M To use Post Card (4 x 6 inch) size
print paper
Remove the 3.5 x 5 inch paper
adaptor and leave the partition laid
down.

H To use 3.5 x 5 inch size print paper
Leave the 3.5 x 5 inch paper adaptor
installed and the partition laid
down.

3.5x5inch
paper

Partition

M To use Small (3.5 x 4 inch) size
paper
Remove the 3.5 x 5 inch paper
adaptor and stand the partition up.
The Small (3.5 x 4 inch) size print
paper is to be set behind the
partition.
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2 Setthe print paper into the tray.
Riffle the print paper. Then insert the print paper with its printing surface
(the side with no imprint) facing up and the arrow pointing in the same
direction as the arrow in the tray. Insert the protective sheet together with
paper, and then remove it after you have placed the paper.
You can set up to 25 sheets for Post Card (4 x 6 inch) size and 30 sheets for
3.5 x 5 inch size and Small (3.5 x 4 inch) size print paper.

Printing surface

Arrow Front side

Do not touch the printing surface. Fingerprints on the printing surface may result
in imperfect printing.

3 Close the paper tray lid. Then push and open the printer’s
paper tray compartment lid and insert the paper tray into the
printer.

Insert it firmly until it clicks into place.

Continued
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[4] Inserting the print paper

® Do not remove or insert the paper tray during printing.

o If print paper does not feed automatically, the [ paper error indicator lights. Pull
out the paper tray and check for a paper jam.

*To avoid paper jam or malfunction on the printer, note the following:
— When adding print paper to a partially full tray, make sure that the total number

of sheets does not exceed 25 for the Post Card (4 x 6 inch) size or 30 for the 3.5 x5
inch size and Small (3.5 x 4 inch) size print paper.

- Do not place different types or sizes of paper in the tray.

— Do not write or type on the printing surface of the paper before printing. If you

want to write greetings or draw on the printed surface after printing, use an oil
ink pen.

- You cannot print on the reverse side of the print paper (ex. the address side of the
Post Card (4 x 6 inch) size print paper).

— Do not print on the used print paper. Printing an image twice on the same paper
will not make the printed image thicker.

— Do not print on the print paper that is ejected from the printer without being
printed.

— Do not attach stickers or anything else on the printing surface before printing.

— Do not remove the backing from sticker print paper before printing.

— Do not fold or bend the print paper before printing.

— Make sure to use the print paper designed for this printer only.

Notes on storing the print paper

 Avoid placing the print paper in a location subject to high temperatures, high
humidity, excessive dust or direct sunlight.

* Avoid storing the paper with the printed faces touching each other or in contact
with rubber or plastic products including vinyl chloride or plasticizer for an
extended period of time; color changes or deterioration of the printed image may
occur.

* When you are going to store partially-used print paper, store it in its original bag.
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Basic printing operations

Printing selected images

You can select an image recorded in the
“Memory Stick” or PC card and print it
at full size.

1

= N W u »

Insert a “Memory Stick” or PC card with recorded images into
the “Memory Stick” or PC card insertion slot (pages 14, 15).

Press the POWER button to turn on the printer.
The POWER indicator lights in green.

(T2 Jrowes

Press the INPUT SELECT button repeatedly until the “MEMORY
STICK"” or PC CARD indicator turns on.

The list of the images stored in the Orange frame (cursor)

“Memory Stick” or PC card is
displayed on the screen.

INPUT
SELECT

-

MEMORY PC

STICK CARD PC
\b
——ll

When “MEMORY STICK” is selected.

All Images ¢ 0135 [

E =
& &
100-0215

Displaying the printer images

When the USB connector is disconnected and the “Memory Stick” or PC card is
removed from the printer, you can display the images stored in the printer by
pressing the INPUT SELECT button. If you press the PRINT button, you can print
the displayed image.

If you do not want to print the image, do not press the PRINT button.

Continued
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Printing the selected image

4 Tap the image you want to print on the screen.

The cursor moves to the tapped image.
Slider and scroll buttons

To display another page

All Images = 0735

When multiple pages exist, you can
switch pages by dragging the slider on
the scroll bar downwards or upwards.
You can also switch pages by tapping the
lower or upper part of the scroll bar or
the scroll buttons [V]/[A] repeatedly.

Creative Print || Effect Ment
5 Press the PRINT button. _-- —

Printing starts. During printing, the PRINT indicator lights. The printing
process bar and the approximate remaining time are displayed on the
screen. For notes during or after printing, see page 27.

To stop printing

Tap [Cancel] on the screen.

6 When printing ends and the print paper automatically emerges
from the paper outlet, remove the printed paper from the
printer.

To display a preview image
Move the cursor to an image that you
want to view in full screen and tap on
the image again. A preview of the

2]
selected image is displayed. *‘ . 2
To display a preview of different
images, tap the scroll buttons [«€]/[»] ;"‘\ Ll s~ .:_i |
repeatedly. To display the image list ! I
again, tap [Image List]. [T, 1 e

Print quantity
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To print the previewed image

To print a copy of the previewed image, press the PRINT button. To print multiple
copies, tap [+] until the desired print quantity is displayed and then press the PRINT
button. To reduce the print quantity, tap [-].

® While the printer is accessing the “Memory Stick” or a PC card, do not eject the
“Memory Stick” or PC card. Otherwise, they may crash.

¢ The displayed image on the screen is not identical in picture quality and colors with
the printed image because phosphor methods or profiles differ. Please regard the
displayed image as just a reference.

Printing multiple images

1 Insert a “Memory Stick” or PC card with recorded images into
the “Memory Stick” or PC card insertion slot (pages 14, 15).

2 Press the POWER button to turn on the printer.
The POWER indicator lights in green.

3 Press the INPUT SELECT button repeatedly until the “MEMORY
STICK” or PC CARD indicator turns on.
The list of the images stored in the “Memory Stick” or PC card is
displayed on the screen.

4 Tap the image you want to print on the screen.
The cursor moves to the tapped image.

5 Tap [+]. Selected image with yellow background
The image is selected and its
background turns to yellow. The
print quantity becomes “1.”

Selected Imaees : 0003/0135[ ]
B < e

K
100-0201 100-0215

To cancel the selection

Tap [-] repeatedly until the print o 101-0011
quantity becomes “0.” The background
turns yellow to gray and the selection is
canceled.

Continued
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Printing the selected image

6 Tap [+] or [-] to set the number of copies to be printed.
Each time you tap [+] or [], the
print quantity increases or
decreases. You can set the print
quantity from 0 to 30.

Print quantity

Selected Images 2 0003/0135 ]

2.
100-02001

To print multiple images

Repeat steps 4 through 6 to select other
images and set the desired print quantity
for each of them.

| 101-0011

7 Press the PRINT button.

Printing starts. During printing, the PRINT indicator lights. The printing
process bar and the approximate remaining time are displayed on the
screen.

When you start printing while the preview image is displayed

Only the preview image is printed.

To stop printing

Tap [Cancel] on the screen. Printing will be canceled from the next print.

8 When printing ends and the print paper automatically emerges
from the paper outlet, remove the printed paper from the
printer.

To edit or process an image
In the image list or preview image screen, tap [Effect] to zoom in and out an
image, move it, adjust the picture quality, or add an special filter to an image

(page 30).

To make a Creative Print of an image
In the image list or preview image screen, tap [Creative Print] to make an
original card, calendar, split images, or stickers (page 36).
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* When the “MEMORY STICK” or PC CARD indicator blinks or the data access message
appears, do not eject the “Memory Stick” or PC card. Otherwise, it may crash.

* While printing, never move or turn off the printer; the print cartridge or paper may
become stuck. If this happens, turn the printer off and on, and resume printing from
the beginning.

* While printing, the print paper is partially ejected from the paper outlet in stages.
Never pull out the paper forcibly until the PRINT indicator turns off and the print
paper emerges automatically.

* When the width or height of an image is smaller than 480 dots, the
image is displayed in a small size. You can print the image but the
printing quality is rough due to its small image size.

* An image without thumbnail data, such as those created with a
computer application, is displayed as the mark shown right. If you 9
select the mark and the preview image is displayed, you can print the
image. If you cannot print, see “Troubleshooting” on page 90.

* Once you have selected images in the “Printing multiple images” procedures, you
cannot print an image with the cursor that is not selected.

* The time required to display a preview image differs depending on the number of
files contained in a “Memory Stick” or PC card, image size, or the file type.

* The time required to display the image list differs depending on the number of files
contained in a “Memory Stick” or PC card, image size, file type or the digital still
camera type.

® The printer cannot display the images saved in a folder of forth or higher hierarchy.

® The image number displayed in the screen is the same as those displayed in your
digital still camera. For a file created with a computer application, the first 8
characters of its file name will be displayed as its image number with the printer.

* When you name or rename an image file on your computer and its file name includes
characters other than alphanumeric characters, the file name may not be displayed
correctly or the image may not be displayed (read error) on the printer.

* Do not leave more than 20 sheets of the ejected printed paper on the paper tray.

* When using your printer in low ambient temperatures, the black lines may be
displayed on the LCD display, which is not of a printer’s malfunction. You can print
an image without problem.

27 GB

suolleado buiuud diseq



Printing all the images or DPOF preset images
at one time

You can print all the images stored in a
“Memory Stick” or PC card at one time.
You can also print all the images with
the print mark ( g ) in the image list
that are DPOF (Digital Print Order
Format) preset for printing with your
digital still camera.

e For how to preset images for printing, see the manual of your digital still camera.

= N W b U

® Some types of digital still cameras do not support the DPOF function or the printer
does not support part of the functions of the digital still camera.

1 Insert a “Memory Stick” or PC card with recorded images into
the “Memory Stick” or PC card insertion slot (pages 14, 15).

2 Press the POWER button to turn on the printer.
The POWER indicator lights in green.

3 Press the INPUT SELECT button repeatedly until the “MEMORY
STICK"” or PC CARD indicator turns on.
The list of the images stored in the “Memory Stick” or PC card is
displayed on the screen.

4 Press the ALL/DPOF button to select the printing mode.
Each time you press the button, the printing mode changes as follows:
ALL printing mode # DPOF printing mode  normal printing mode

ALL/DPOF

-_—
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When you select the ALL printing Memary Stick
mode, all the images in the image
list are displayed with yellow
backgrounds.

B TR

When you select the DPOF printing
mode, only the preset images with
the print mark are displayed with
yellow background.

When you select DPOF. Creatve Print| [ -]

Press the PRINT button.

Printing starts. When you select the ALL printing mode, all the images in
the “Memory Stick” or PC card are printed one by one in the order of their
image numbers. When you select the DPOF printing mode, all the DPOF
preset images are printed in the order they were displayed.

When you select the ALL printing mode, the print quantity is automatically set to
one copy and you cannot set the print quantity.

1 sl -
110-0008

To stop printing

Tap [Cancel] on the screen. Printing will be canceled from the next print.

When printing ends and the print paper automatically emerges
from the paper outlet, remove the printed paper from the
printer.

For notes during or after printing, see page 27.

Tip
Even if a smaller number of sheets of print paper than the print quantity are
installed in the paper tray, you can proceed with printing. If a message appears,
follow the instructions on the screen to replace the printing pack and proceed with
printing.

29 GB
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Advanced printing operations

Adding effects to an image (Effect)

What you can do with the Effect menu

30 GB

The Effect menu allows you to edit, adjust or add special filters to an image
that is positioned with the cursor in the image list or displayed in the preview
screen.

To display the main Effect menu,
tap [Effect] below the image list or
preview screen:

copies: 111

X

Tap the desired item to display the sub menu screen to edit, adjust, or add
special filter to an image.

Item Functions

Edit Enlarges, reduces, moves or rotates an image. (Page 32)

Adjust Adjusts the brightness, saturation, tint, and sharpness of
an image. (Page 33)

Filter Adds a special filter to an image to print it like painted
pictures, in sepia, or in monochrome. (Page 35)

Save Displays the dialog box to save the edited image as an
new image.

To return to the previous procedure and redo the operation
Tap [Back]. The screen returns to the preceding procedure; do the procedure
again.

To print the edited image

Tap [+] or [-] to set the copies to be printed and then press the PRINT button.
The currently displayed image will be printed. To cancel printing, tap
[Cancel] in the screen. When multiple copies are printed, printing from the
next print will be canceled.



To save the image with the selected effects
You can save the edited image as a new image in the “Memory Stick” or PC
card. The original image remains as it is.

1 Tap [Savel.
A dialog box to choose the destination where you save an image either
from “Memory Stick” or PC card is displayed.

2 Tap the desired media to save an image.
The edited image is saved as a new image with a new image number.
When saving completes, the new image number is displayed.

3 Tap [OK].
The image is saved in JPEG format without regards to the original image
file format.

To change the printer settings midway
Tap [Menu]. The Menu screen is displayed and you can change the printer
settings (page 57).

To exit the Effect menu

Tap [Exit]. When you have edited an image, the confirmation dialog box for
saving the image is displayed. Tap [Yes] to proceed with the saving
procedures mentioned above or [No] to abandon edition and exit the Effect
menu. Tap [Cancel] to return to the Effect menu.

eIt may take longer to process an edited image after you press the PRINT button.

* Do not remove the “Memory Stick” or PC card while in the Effect mode. If you do,
the Effect mode ends forcibly and any editing you have done is canceled.

* While saving the image, do not turn off the power or remove the “Memory Stick” or
PC card from the insertion slot. The “Memory Stick” or PC card may be damaged.

o If the “Memory Stick” or PC card is in write protect status, you cannot save an image
in the “Memory Stick” or PC card.

o If an extremely oblong image is edited, margins may appear in the upper or bottom
parts of the image.

* For the “Memory Stick”, see page 86. For the PC card, see page 89.
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Adding effects to an image (Effect)

Changing the image size and position
The Edit sub menu allows you to enlarge, reduce, rotate, or flip an image.

1 Move the cursor to the desired image in the image list or tap it
again to display its preview.

2 Tap [Effect].
The Effect menu is displayed (page 30).

3 Tap [Edit].
The Edit sub menu is displayed.

4 Tap the desired item to edit the image.

Items Procedures

o/® Each time you tap @ or ©, the image is enlarged or
reduced. (When it reaches to its maximum or
minimum size, an image will not be enlarged or
reduced any further.)

0/d/=9/= Tap [11/B1//=] to move the image in the desired
direction. You can also drag the image in the preview
to the desired direction.

/ Each time you tap / @, the image rates 90°

counterclockwise or clockwise.

copies:1 (1 copies: T

QQl

a
k=l
o

5 tem. 5 em.
R i R

When you move an image
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The picture quality of an enlarged image may be deteriorated depending on the size
of the image.

Tap [Back].
The Effect menu is displayed again. You can select another Effect sub
menu, save or print the image, or exit the Effect menu (pages 30-31).

Adjusting the picture quality

The Adjustment sub menu allows you to adjust brightness, saturation, tint, or
sharpness levels of the image pictures.

1

2

Move the cursor to the desired image in the image list or tap it
again to display its preview.

Tap [Effect].
The Effect menu is displayed (page 30).

Tap [Adjust].
The Adjustment sub menu is displayed.

Tap the desired adjustment item.
The adjustment screen of the selected item is displayed.

Copies:[_1][H]
[ Light

=0 &l

nd then tap [Back].
(e ] =]

When you tap [Brightness]

Slider

Continued
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Adding effects to an image (Effect)

5 Drag the slider upwards or downwards, or tap the upper or
lower part or [V]/[A] on the scroll bar repeatedly to adjust the

image.

ltems Procedures

Brightness Move the slider upwards to brighten the image or
downwards to darken the image.

Saturation Move the slider upwards to deepen the colors of the
image or downwards to lighten the colors of the image.

Tint Move the slider upwards to make the image reddish or
downward to make the image bluish.

Sharpness Move the slider upwards to sharpen the outlines of the
image or downwards to weaken the outlines of the
image.

The picture quality of the image being displayed on the screen may differ from that
of the printed image.

6 Tap [Back].
The Adjustment sub menu is displayed again. You can select another
adjustment item to proceed with further adjustments.

7 Ta p [Back].
The main Effect menu is displayed again. You can select another Effect sub
menu, save or print the image, or exit the Effect menu (pages 30-31).
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Adding a special filter to an image

The Filter sub menu allows you to add a special effect to an image to print in
monochrome, paint, or sepia tone.

1

2

Move the cursor to the desired image in the image list or tap it
again to display its preview.

Tap [Effect].
The Effect menu is displayed (page 30).

Tap [Filter].
The Filter sub menu is displayed.

Tap a filter you want to add to an image.

Items Filters

Paint Makes the image look like a painted picture.

Sepia Makes the image look like an old photograph with faded
colors.

Monochrome  Makes the image into a monochrome picture.

Normal Adds no filter to an image. Removes any added filter(s)
and resets to the original image.

The picture of the image being displayed on the screen may differ from that of the
printed image.

Tap [Back].
The main Effect menu is displayed again. You can select another Effect sub
menu, save or print the image, or exit the Effect menu (pages 30-31).

35 GB
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Making various prints (Creative Print)

What you can do with the Creative Print menu

36 GB

The Creative Print menu allows you to make a variety of prints.

To display the Creative Print top Creativs Print @
menu, tap [Creative Print] below H ‘
. , . . B
the image list or preview screen: ‘ | Card l \Sticker
‘__ _f‘;alendar } -Iﬁdex Print

Split Image
R I

Tap the desired item and make a card, calendar, split image, sticker or index
print.

Items Functions

Card Adds a selected message and input characters to make an
original card. (Page 38)

Calendar Add a calendar of selected month(s) to an image or
images to make an original calendar. (Page 41)

Split Image Makes 2-, 4-, 9-, 13-, or 16-split images prints. (Page 43)
Sticker Makes a 9-split framed image sticker. (Page 44)
Index Print Makes an index print of all the images stored in the

“Memory Stick” or PC card. (Page 46)

To add pictures or characters to an image (Tool)

For all the Creative Print sub menus except for the Index Print, you can tap
[Tool] in a preview screen to display the Tool screen. In the Tool screen, you
can add drawings, stamps, characters, cut out images or messages to an image

(page 48).

To return to the previous procedure and redo the operation

Tap [Back]. The screen returns to the preceding procedure; do the procedure
again.



To print the edited image

Tap [+] or [-] to set the copies to be printed and then press the PRINT button.
The currently displayed image will be printed. To cancel printing, tap [Cancel]
in the screen. When multiple copies are printed, printing from the next print
will be canceled.

To save the Creative Print image
You can save the edited image as a new image in the “Memory Stick” or PC
card. The original image remains as it is.

1 Tap [Savel.
A dialog box to choose the destination where you save an image either
from “Memory Stick” or PC card is displayed.

2 Tap the desired media to save an image.
The edited image is saved as a new image with a new image number.
When saving completes, the new image number is displayed.

3 Tap [OK].
The image is saved in JPEG format without regards to the original image
file format.

To change the printer settings midway
Tap [Menu]. The Menu screen is displayed and you can change the printer
settings (page 57).

To exit the Creative Print menu

Tap [Exit]. When you have edited an image, the confirmation dialog box for
saving the image is displayed. Tap [Yes] to proceed with the saving
procedures mentioned above or [No] to abandon edition and exit the Creative
Print menu. Tap [Cancel] to return to the Creative Print menu.

* While saving the image, do not turn off the power or remove the “Memory Stick” or
PC card from the insertion slot. The “Memory Stick” or PC card may be damaged.

o If the “Memory Stick” or PC card is in write protect status, you cannot save an image
in the “Memory Stick” or PC card.

e For the “Memory Stick”, see page 86. For the PC card, see page 89.

37 GB
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Making various prints (Creative Print)

Making a card

38 GB

You can add a selected and your input messages to images e—

and make an original card like the one sho

1 Tap [Card] in the Creative Print
top menu (page 36).
The print size selection screen is
displayed. Select the print paper size
you want to use.

2 Tap the desired paper size icon.
The screen used for selecting a
template of the selected paper size is
displayed.

When you select “Postcard Size”

3 Tap the desired template.

A preview of the selected template is
displayed.

Message area

Image area —

wn on the right. @@@

Gard/Sekct Print Size (0N

Print Size

|| =

Postcard Size  3.5xSinch Size Srmall Size

ot Template (|

Template for Posteard Size

Copies:[_11 [

lTonEl

Character input area

h ITem

e =]



4 Tap each area on the preview to enter a message, image(s), or

characters.
You can choose them in any order.

B Entering a message

@ Tap the message area. @
The screen used for selecting a L SEwiTs Hedines ]
message is displayed. | Season's Greetings | U

To change the message color [ Terry Christmas |
The messages are printed in the L Happy Birthday 1@
color displayed in the [Select

Color]. To Change the color, tap br and then sekot the messags
[Select Color] to display the color
selection window. Tap the

desired color.

fent

@ Tap the desired message.

A preview is displayed. The selected message is displayed in the
message area in the selected color.

H Selecting an image

When you select a template with multiple images, select an image for each

image area.

@ Insert a “Memory Stick” or PC
card into the printer and tap an
image area.

All Images: 0135 [T

The image list used for selecting
an image is displayed.

Continued
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Making various prints (Creative Print)

@ Tap the desired image. Gard, Adjust Imaes i
The screen used to adjust the clal
image size, position, angle, and n%u
brightness is displayed.

g play
Brightness
® Tap the desired adjustment
button and make your

adjustments
Items Procedures
/@ Each time you tap @ or ©, the image is enlarged or

reduced. (When it reaches to its maximum or
minimum size, an image will not be enlarged or
reduced any further.)

0l/01/8/81  Tap 1/31/E/B] to move the image in the desired
direction. You can also drag the image in the preview
to the desired direction.

/ Each time you tap / , the image rotates 90°

counterclockwise or clockwise.

Brightness The brightness adjustment slider is displayed. Drag
the slider upwards to brighten the image or
downwards to darken the image. You can also move
the slider by tapping upper/lower part or [V]/[A] on
the scroll bar. To fix the adjustment and return to the
image adjustment screen, tap [Enter].

@® Tap [Enter].
A preview image is displayed. The selected image is displayed in the
image area. When you choose a template with multiple images, repeat
steps O) through @ to select the remaining image(s) for each image
area.

B Entering characters

When you choose a template with characters, you can enter characters.
Tap the character input area to display the character input screen. For
how to input characters, see “Typing characters” on page 50.
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Copies:[_1] [

5 Check the preview.
You can print or save the created s
image (pages 36-37).

l Tool l

Save

Top Menu

Back

Making a calendar

You can add a selected calendar to an image or images
to make an original calendar.

Ment

—_

1 Tap [Calendar] in the Creative Print top menu (page 36).

The print size selection screen is displayed (page 38).

2 Tap the desired paper size icon. EEEEEEEEEE

The screen used for selecting a SRR O

calendar template for the selected
print paper size is displayed.

=

emp late

When you select “Postcard Size”

Continued
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Making various prints (Creative Print)

3 Tap the desired template.
A preview of the selected template is displayed.

Galendars Preview

copies:[__1] [
December

Image area A B c

e —
e e

Calendar area

4 Tap each area on the preview to set the calendar and add
image(s).
You can choose them in any order.

H Selecting an image

Tap the image area to select and adjust an image. For details, see
“Selecting an image” on pages 39-40.

H Setting the calendar

@ Tap the calendar area. Galendar/ Set Up [l
The screen used for setting the Start Month: |12 |enth[ 2002 | vear
calendar is displayed. G

. Color of Day s - -

@ In the “Start Month” line, set the slorofDays [ Sun.in red/Sat in biue_|
month and year to start the [ Sundayio e J
calendar.

Tap the month box and tap [A]/
[V] to set the month. Set the year
in the same way.

® In the “Start Date” line, set the day starting the week (placed furthest
left in the calendar).

Tap [Sunday] or [Monday].
@ In the “Color of Day” line, set the color of the days.

Tap [Sun.in red /Sat.in blue] (Sundays in red /Saturdays in blue) or
[Sunday in red].
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® Tap [Enter].
A preview of the calendar is displayed. The selected calendar is
displayed in the calendar area.

5 Check -the preVIeW Galendar/ Preview ) Copies:[_ T[]

You can print or save the created ot
image (pages 36-37).

Making a split print

You can make a print with 2-split, 4-split, 9-split, 13-split, or
16-split images.

4-split images

1 Tap [Split Image] in the Creative Print top menu (page 36).
The print size selection screen is displayed (page 38).

2 Tap the desired paper size icon. : (ol
The screen for selecting the split Template for Postoard S iee
image template for the selected print A AlB[cC
paper size is displayed. A P g ﬁ ':
A[A]A 2 2 g : [A]BIC B
NEIEY | i | Eaesen

When you select “Postcard Size”

Continued
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Making various prints (Creative Print)

3 Tap the desired template. R e T
The preview of the selected template
is displayed. Q

4 nsert a “Memory Stick” or PC

card into the printer and tap
an image area.

When you choose a template with
multiple images, you can select from
any image area.

5 Select and adjust an image.

For details on selecting and adjusting an image, see “Selecting an image”
on pages 39-40.

6 Check the preview.
You can print or save the created image (pages 36-37).

Making a sticker

A4, GB

You can add a frame to each of the 9-split images to make a
9-split image sticker.

To make a 9-split image sticker, you can use the Small (3.5 x 4 inch) size print paper
only. Before making a sticker, make sure to feed the Small (3.5 x 4 inch) size 9-split
sticker print paper (SVM-30SW09) into the printer.

1 Tap [Sticker] in the Creative ARG LB
Print top menu (page 36). e
The screen used for selecting a Lo ||| oD ||| [oEE
sticker template for the Small (3.5 x 4 {2 5 :} {: A :} {: §}

inch) size print paper is displayed.




copies:[_1] (18R

Tap the desired 9-split — .

template. f = =l ;

A preview of the selected templateis | | I

displayed. A A A [ Top Menu l
Al A all

e

Tap an image area.

When you choose a template with
multiple images, you can select from
any image area. The screen used for
selecting a frame is displayed.

Insert a “Memory Stick” or PC
card into the printer and then
tap the desired frame.

The screen used for selecting an
image is displayed.

Tap the desired image.
The image is displayed with the frame. The image adjustment screen is
displayed.

Adjust the framed image and then tap [Enter].
For how to adjust an image, see page 40.

Repeat steps 3 through 6 to add and adjust framed image(s) to
the remaining image area(s).

Check the preview.
You can print or save the created image (pages 36-37).

45 o
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Making various prints (Creative Print)

Making an index print

You can make an index print of the images in the “Memory Stick” or PC card.
You can also enter a title of the index print.

1 Tap [Index Print] in the Creative Print top menu (page 36).
The print size selection screen is displayed (page 38).

2 Tap the desired paper size icon. EEEEEETE m
The window for selecting title and _
print pattern is displayed. it Sl

Pattem: [@ 2x2 |[o axa |[o exs |
[@8x5 |[o 8xs |[o10xs |

ttern and then tap [Enter].

3 In the Title line, tap either [On] to add a title or [Off] to add no
title.

When you select “Postcard Size”

4 Tap the desired print pattern.

Patterns differ depending on the paper size and whether you input a title
or not. When you select [10 x 8], for example, 10 (horizontally) by 8
(vertically) images are printed on a sheet of print paper.

5 Tap [Enter].
The preview of the selected pattern is displayed.

Selected Images: 0136/0135 [

| l Select Image I

Title area (only when you
select [On] for the Title.)

Image area

46



6 Tap each area on the preview to enter a title and image(s).
You can choose them in any order.

H Entering a title

When you choose [On] for the Title, you can enter characters as a title.
Tap the title input area to display the character input screen. For how to
input characters, see “Typing characters” on page 50.

M Selecting an image
All the images are by default selected. You can print all the images or
selected images only.
*To print all the image stored in a “Memory Stick” or PC card, do not
tap the image area but skip to step 7.
*To print only selected images, tap the image area to display the image
selection window. Tap and cancel the selection of the images that you
do not want to print. Tap [Back] to return to the preview screen.

7 Check the preview and press the PRINT button.
The index list of the “Memory Stick” or PC card images is printed in the
selected pattern. Each image is printed with corresponding image
number. When the title is input, title is also printed. When “Date Print”
is selected, the date (year, month and day) when the image is taken or
saved is also printed with the image.

To stop printing
Tap [Cancel] in the screen. When multiple copies are printed, printing from
the next print will be canceled.

* You cannot print the images that are not displayed as thumbnails in the image list
because they are damaged or for some other reason.

¢ The shot date is printed only when an image is a JPEG file recorded in the DCF
(Design rule for Camera File system) format. To make a print with the shot date,
please shoot an image in the JPEG file format.
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Making various prints (Creative Print)

Adding pictures or characters to an image (Tool)

48 o

For all the Creative Print sub menus except for the Index Print, you can tap
[Tool] in a preview screen to display the Tool screen. The Tool screen allows
you to add pictures and characters to the desired position on an image. In each

Creative Print sub menu, the same character input screen as in the Tool screen

appears.
1 Tap [Tool] in the Creative Print Copies:[__T1 1
preview screen. | G 4 [V

The Tool screen is displayed. @

2 Tap the desired tool in the Save

Tools box and draw freehand
lines, put on stamps, input
characters, add cut out images,
or add messages in the

preview. Preview Tools box
Icons Tools Functions
Pencil Displays the pencil screen to draw freehand line art on the
preview. (Page 49)
T e isplays the character input screen to enter characters to
Typ Displays the ch. inp h
be added to the preview. (Page 50)
p
Stamp Displays the stamp selection screen showing stamps to be
pasted to the preview. (Page 53)
[@] Cutout Displays the shape selection screen to paste a selected
image with or without cut. (Page 54)
Message  Displays the message selection screen showing messages

to be pasted to the preview. (Page 55)

Save Displays the dialog box to choose the destination media
where you save the edited image.
Exit Returns to the screen displayed before the Tool screen is

displayed.

For printing, saving and other operations, see pages 36 and 37.



Drawing freehand line art ((£])

You can use the pencil tool to draw freehand line art on the preview.

1

In the Tool screen (page 48),
tap [Z] (Pencil tool).

The pencil tool screen is displayed.

To select the color for the
pencil drawings, tap
(Color).

The color selection screen is displayed. g

Tap the desired color box.

The color tapped is selected and the
color selection screen is closed.

To select the stroke weight for
the pencil drawings, tap [«]
(thin), [#] (medium), or [e]
(thick).

Tap and draw a freehand line
on the preview.

The line formed from the point you
start drawing to the point you lift
the stylus becomes a stroke.

Bl To erase the drawing

Tap [Cancel]. The drawing just
made is erased from the preview.

B To move the drawing

Card/ Tool

Copies:[_1] [

D

Enter
and then tap [Enter].
I —

Tap [11/01/[E/5] to move the drawing in the desired direction.

Note

There may be restrictions on length of a line or/and number of lines. If this occurs,

a warning beep sounds.

Continued
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Making various prints (Creative Print)

6 Tap [Enter].

The drawing you made is fixed and pasted to the preview. The Tool top
screen is displayed. You can use another tool, print the created image, or
save it (page 48).

Typing characters ((T])

You can use the type tool to input the maximum of 5 lines of characters to be
pasted to the preview.

50 GB

1

Select color and font (5 fonts available) for
the characters.

In the Tool screen (page 48),

tap (Type tool). Orina Character input box

Creative Print preview screen, _ l

tap the character input area.
The character input screen is | W Font calor || Afont |

displayed.
Tap the characters you want to
input in the keyboard.

The tapped characters are entered in L 2Lt I
he input box. 7
o A1
t p [ocaps |[Load/Save] | Datete |
H To select a capital letter Keyboard

Tap [Caps] to display the capital characters keyboard. Then tap the
desired character. To enter a small letter, tap [Caps] again.

M To select the font

The characters are input in the font displayed next ABCDEFGHIJK
to [Font]. To select a different font, tap [Font] until ABCDEFGHIJK

the desired font is displayed: ABCDEFGHIJK

ABCDEFGHIJK
ABCDEFGHIJK
H To select the color

The characters are input in the color displayed in [Font color]. To select a
different color, tap [Font color] to display the color selection screen. Then
tap the desired color box.



B To change lines

Tap [ to enter the next line. To return to the previous line, tap [4] in the
side of the character input box repeatedly until the previous line is
displayed. To move to the next line, tap [»] in the side of the character
input box repeatedly until the next line is displayed.

H To enter a message

The maximum of 200 characters that you frequently use can be registered
as a message. You can register and load three messages as follows:

@ Enter up to 200 characters in the input box that you want to register as a
message.

® Tap [Load/Save].

The dialog box to register and save messages is displayed.
® Tap [Save].

The message selection screen is displayed.
(@ Tap the message as which you want register the characters.

The characters are saved as the selected message.

To insert the message in the input  BEEIEEEIES
box, tap the space in the text box
where you want to enter the Messse=T| Happy Birt holay! |
message and then tap [Load/
Save]. Tap [Load] and then tap
the desired message. The Message3] Happy New “Year |
selected message is inserted in the
character input box.

MessagaZl Congratulations |

B To delete or change characters in the input box

*To delete a character before the cursor
Tap [Delete]. To delete a character in the middle of the input box, tap
the space after the character you want to delete and then tap [Delete].
Each time you tap [Delete], the character before the cursor is deleted.
*To insert characters in the input box
Tap the position you want to insert characters in the input box. Then
enter characters.

Continued
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Making various prints (Creative Print)

3 Tap [Exit]. Cov 0y Sy
The character input screen is closed @
and the input characters are pasted ﬂ'ﬁ-
onto the preview. A [HAPPYE] ©

4 Adjust the size, position and
angle of the characters. _ IC e |

«t and then tap [Enter]

e

Items Procedures
e/® Each time you tap @ or ©, the characters are enlarged

or reduced. (When they reach to their maximum or
minimum size, the characters will not be enlarged or
reduced any further.)

T/01/-4/2) Tap [11/01/[/5] to move the characters in the
desired direction. You can also drag the characters in
the preview to the desired direction.

/ Each time you tap |£1}/ , the characters rotate 90°

counterclockwise or clockwise.

Cancel The input characters are erased and the Tool top
screen is displayed again.

5 Tap [Enter].
The characters are fixed to the preview. The Tool top screen is displayed.
You can use another tool, print the created image, or save it (page 48).

Once you tap [Enter], you cannot move or delete the characters.
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Pasting stamps (&)

You can use the stamp tool to paste a selected stamp to the preview.

1

In the Tool screen (page 48),
tap =/ (Stamp tool).

The stamp selection screen is
displayed.

Tap the desired stamp.
The tapped stamp is selected and the
stamp selection screen is closed.

Tap on the preview image

where you want to paste the
copies:[_ 1101

stamp.
The selected stamp is pasted onto Message @
the preview. [« ,En

Adjust the size, position and

angle of the stamp. EI
For how to adjust the stamp, see the = Erer |
Step 4in page 52. ouch to place ﬂ-\fz- stamp and then tap [Enter].

R —
Tap [Enter].

The stamp is fixed to the preview. The Tool top screen is displayed. You
can use another tool, print the created image, or save it (page 48).

Once you tap [Enter], you cannot move or delete the stamp.

Continued
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Making various prints (Creative Print)

Pasting cut out images (&)

You can use the cut out tool to paste a selected image with or without cut.

1 Inthe Tool screen (page 48),
tap [&] (Cut out tool).
The shape selection screen is
displayed.

2 Inserta “Memory Stick” or PC
card into the printer and tap
the desired shape.

The image list used for selecting an
image is displayed.

3 Tap the desired image.
The image is displayed in the
selected shape. The image
adjustment screen is displayed.
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4 Adjust the cut out image and L i o —creel_TI0

then tap [Enter].

For how to adjust an image, see page

40. The cut out image is pasted onto A c

the preview.
To cancel the operation T Enter

T C 11. Th t ti . Adil,i:;trf}:uf image and then 'a,l:_',[,Em'Ei] —
ap [Cancel] e cut out image is = e

erased from the preview.

5 Adjust the size and position of the cut out image.
For how to adjust the cut out image, see the step 4 in page 52.

6 Tap [Enter].

The cut out image is fixed to the preview. The Tool top screen is

displayed. You can use another tool, print the created image, or save it

(page 48).

Once you tap [Enter], you cannot move or delete the cut out image.

Pasting messages (&)

You can use the message tool to paste a selected message to the preview.

1 Inthe Tool screen (page 48), @
tap (&) (Message tool). [ Scason'’s Greelings )
The message selection screen is H I T I I!
displayed. L Mevy Chuidmas |

1 Merry Christmas |
To change the message color [ Happy Birthday 1@

The messages are printed in the color
displayed in the [Select Color]. To
change the color, tap [Select Color] to
display the color selection window. Tap
the desired color.

(W] Select Color

Continued
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Making various prints (Creative Print)

. Gard/ Tool Copies: M

2 Tap the desired message. UDES@@
The selected message in the selected : [+

color is pasted onto the preview.

A[Happy Birthday] c

To cancel the operation

Tap [Cancel]. The message is erased
from the preview.

e and then tap [Enter].

3 Adjust the size, position and angle of the message.
For how to adjust the stamp, see the step 4 in page 52.

4 Tap [Enter].
The message is fixed to the preview. The Tool top screen is displayed.
You can use another tool, print the created image, or save it (page 48).

Once you tap [Enter], you cannot move or delete the message.
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Setting up the printer (MENU)

What you can do with the Menu

The Menu allows you to change the printer settings, set up the screen, perform
slide show, or delete images.

;
To display the Menu screen, il
tap [Menu] below the image _ _ ;
list or preview screen: ‘ Print Setting ‘ Slide Show
‘ Options ‘ Delete Image

an item.

Tap the Menu sub menu item and make the settings.

Items Functions

Print Setting Change the printing preferences including the Auto Fine
Print 2, date print, print finish (border/borderless print,
glossy /texture finish), or color settings. (Page 58)

Options Sets the clock and beep. You can also adjust the LCD display
contrast. (Page 61)

Slide Show Performs a slide show of the images in the “Memory Stick”
or PC card. (Page 63)

Delete Image  Deletes the selected image in the “Memory Stick” or PC card.
You can also format the “Memory Stick.” (Page 64)

To exit the Menu
Tap [EXIT]. The screen displayed before you entered the Menu screen is
displayed.

Continued
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Setting up the printer (MENU)

Changing the print preferences (Print Setting)

58 GB

The Print Setting screen allows you to change the print preferences including
Auto Fine Print 2, border/borderless print, print finish (glossy/texture), date

print, and color setting.

1 Tap [Print Setting] in the Menu

screen (page 57) .

The Print Setting window is
displayed.

to select.

The yellow circle indicates the
setting item has been selected.

(*: Default settings)

Tap the setting items you want

Print Setting

Auto Fine Print Date Print *

[© High J[@ Low | [@ on J[o o0if |

o _oif_|

Borders : Color Setting

R0

=8 ﬁ ]
I

Set each item

You cannot select the menu items that cannot be changed.

Items Settings

Contents

Auto Fine Print 2

High/Low*

Corrects an image automatically for printing
in better picture quality. You can select the
level of adjustments between “High” or
“Low”. When “High” or “Low” is selected,
an image shot by an Exif Print (Exif 2.2)-
compatible digital still camera is
automatically adjusted to its optimum
picture quality and printed.

® The image on the screen is not corrected.

® When printing from a computer, the Auto Fine
Print 2 function does not work.

OFF

Prints an image without any corrections.




Items Settings Contents

Borders Yes Prints an image with borders around the
image.

Depending on an image, its top and bottom edges
or right and left edges may be cut and printed.

No* Prints an image without blank space around
the image.

* You cannot make borderless prints with Small
(3.5 x 4 inch) size print paper.

* When printing a standard 4:3 picture shot by a
digital still camera, the top and bottom edges of
the image are cut and it is printed as a 3:2
picture.

Glossy*  Prints an image vividly with glossy finish.

Texture  Prints an image softly with a uniform and
uneven finish.

Date Print On Prints the shot date with an image when the
image is a JPEG file recorded in the DCF
(Design rule for Camera File system) format
(page 96). To make a print with the shot
date, please shoot an image in the JPEG file
format.
When the image is saved after edited with
the printer, the saved date is printed.

To record the date precisely, set the clock in
advance (page 61).

Off* Prints an image without the date print data.

Continued
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Setting up the printer (MENU)

60 GB

Items Settings

Color Setting  Adjusts the color reproduction of the printer. Drag the
adjustment slider of each color or tap [+] or [-] to set the
level to a higher value (+1, +2) or a lower value (-1, -2).
(*R: 0/G:0/B:0)

R: Adjusts the red and blue elements. The higher you
set the level, the picture becomes reddish as if it
receives red light. The lower you set the level, the
picture becomes darker with red fading as if light
blue is added.

G: Adjusts the green and purple elements. The higher
you set the level, the picture becomes greenish as if it
receives green light. The lower you set the level, the
picture becomes darker with green fading as if red
purple is added.

B: Adjusts the blue and yellow elements. The higher
you set the level, the picture becomes bluish as if it
receives blue light. The lower you set the level, the
picture becomes darker with blue fading as if yellow
is added.

3 Tap [Back].

The Menu screen is displayed again.

To exit the menu

Tap [Exit]. The screen displayed before you entered the Menu screen is
displayed.



Changing the printer preferences (Options)

You can change the printer preferences and adjust the LCD screen contrast of

the printer.
1 Tap [Options] in the Menu s
screen (page 57) . Beep:

Date./Clock Setting :

2 Tap the setting items you want 2002 /02401 17 : 45
to select. Display Contrast : -
The yellow circle indicates the per & g & o
setting item has been selected. Exit
(*: Default settings)

You cannot select the menu items that cannot be changed.

The Options window is displayed.

Set each item

Items Settings
Beep On* The warning and operation sound beeps.
Off No warning or operation sound beeps.

Date/Clock  You can set the internal clock to record the date you saved
Setting the image in the “Memory Stick” or PC card.
1 Tap [Setting] to enter the clock setting mode.
2 Tap [A] /[V¥] to set the year.
Tap [A] to increase the number and tap [V] to decrease
the number.
3 Tap the month box (for NTSC) or the day box (for the
PAL) and then tap [A] /[V] to set the month or day.
4 Set the day or month, the hour and minutes in the same
way.
5 Tap [Enter] to start the internal clock.

If you unplug the AC power cord, the clock setting will become
invalid within a few hours. In this case, please set the clock again.

Continued
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Setting up the printer (MENU)
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Items Settings

Display Contrast ~ Drag the adjustment slider or tap [«]/[»] or
anywhere on the bar to adjust the LCD display
contrast level. The adjusted level holds effective until
you change the level.

3 Tap [Back].

The Menu screen is displayed again.

To exit the menu
Tap [Exit]. The screen displayed before you entered the Menu screen is
displayed.



Viewing a slide show

You can perform a slide show of the images saved in a “Memory Stick” or PC
card.

1

Tap [Slide Show] in the Menu
screen (page 57).

The Slide Show screen is displayed. Slideshow :
In the Switch Time line, tap T

[Fast] to switch images quickly

or [Slow] to switch them

slowly. Exit
itch Time, Tap [Ex

Tap [Execute].
The images in the “Memory Stick” or PC card are displayed one after
another in the selected switch time like a slide show.

To stop the slide show
Tap anywhere on the screen. The screen that has been displayed before you
select the Menu appears.

® When you select [Slow] in the Switch Time, it may take long for an image to be

displayed depending on the image.

* You cannot view the slide show while the Creative Print or Effect menu is selected.
*You cannot display the images that are not displayed as thumbnails in the image list

because they are damaged or for some other reason.
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Deleting images

You can delete selected images in the “Memory Stick” or PC card. You can also
format the “Memory Stick.”

¢ During deleting or formatting, do not turn off the power or remove the “Memory
Stick” or PC card from the insertion slot. The “Memory Stick” or PC card may be
damaged.

o If the “Memory Stick” or PC card is in write protect status, you cannot delete images
or format the “Memory Stick.”

® When you select [Deleting Image], you cannot delete an image protected or preset by
DPOF.

* An image, once deleted, will be lost forever. Before deleting an image, double-check
that it is the right one.

* When formatting a “Memory Stick,” all the files including the image files will be
deleted.

*You cannot format a PC card.
* You cannot delete an image while the Creative Print or Effect menu is selected.
® You cannot format or delete an image in the “Memory Stick-ROM”.

Deleting the selected images

64 o

You can delete selected images in the “Memory Stick” or PC card.

1 Tap [Delete Image] in the Delete Image
Menu screen (page 57).

The Delete Image screen is ‘ Deleting Image
displayed.

I Memory Stick Format

2 Tap [Deleting Image].
The image list is displayed.




3 Tap the image that you want
to delete.
The selected image is displayed in
yellow background with a trash
icon. To delete multiple images at a
time, repeat this step.

To cancel deletion

Tap [Exit].

4 Tap [Execute] .

The confirmation message is displayed.

5 Tap [Yes] to delete the selected image or [No] to cancel
deletion.
The selected image is deleted and the image list is displayed.

6 To exit the Menu, tap [Exit].
The screen displayed before you enter the Menu screen is displayed.

Formatting a “Memory Stick”

You can format a “Memory Stick.” In step 2 in “Deleting the selected images” ,
tap [Memory Stick Format]. When the confirmation dialog box is displayed,

tap [Yes] to proceed with formatting or tap [No] to cancel formatting.

When you format a “Memory Stick”, all the images inside are deleted.
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Printing from your computer

Using your printer with Windows computers

The supplied DPP-EX7 printer driver enables you to print an image stored on
your computer with the Digital Photo Printer DPP-EX7. To print an image
from the computer, you need commercially available printing application
software.

System requirements

To use the supplied software, you need a computer that meets the following
system requirements:

os: Microsoft Windows 98/Windows 98SE/Windows Me/
Windows 2000 Professional/ Windows XP Home
Edition/Windows XP Professional should be
pre-installed.

The operating system should be factory-installed. We cannot
guarantee the operations for the above operating systems if they
are upgraded from a former version of Windows.

CPU: MMX Pentium 233 MHz or above is recommended.

RAM: 64 MB or more is recommended.

Hard disk space: 200 MB or more is recommended. (It differs depending
on the number of copies to be printed.)

Port: A USB port should be installed as standard.

Drive: CD-ROM drive (for software installation)

* We cannot guarantee printer operations when a hub is used or when two or more
USB devices including other printer are connected to your computer.

e If you connect more than one DPP-SV88/SV77/SV55/MP1/EX7/EXS5 printer at the
same time, you cannot operate the printer.

* You cannot operate the printer from another USB device being used simultaneously.

* Do not remove or connect the USB cable from or into the printer during the data
communication or printing. The printer may not work properly.

e The printer does not support system standby /hibernate mode of the computer.
During printing, do not make your computer change to system standby /hibernate
mode.

* We cannot guarantee operations with all the personal computers with the system
requirements.
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Installing the printer driver

Install the printer driver contained on the supplied CD-ROM to your
computer.

1 Make sure that the printer is not connected to the computer.

2 Turnon your computer and start Windows.

*When installing or uninstalling the software in Windows® 2000
Professional, log on Windows as the user name of “Administrator” or
“Power user”.

*When installing or uninstalling the software in Windows® XP
Professional /Home Edition, log on as a user name with the “Computer
administrator” user account.

* Be sure to close all running programs before installing the software.

® The dialog boxes in this section are those in Windows XP Professional, unless
otherwise specified. The installation procedures and the dialog boxes shown
differ depending on the operation system.

3 Insert the supplied CD-ROM
into the CD-ROM drive of your
computer and double-click
“Setup” in the CD-ROM.

e If you connect the printer to your computer before installing the driver, the
dialog box to request the driver is displayed. If this occurs, click “Cancel” to
close the dialog box. Then remove the printer from your computer and redo the
installation procedures.

o If you cancel the installation midway, do the installation procedures from the
step 3.

o If the installation fails, remove the printer from your computer, restart your
computer, and then do the installation procedures from the step 3.

Continued
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Using your printer with Windows computers

The “Sony DPP-EX5/EX7 Setup”
dialog box appears.

4 Click “Next” to start installation. (EEEED =

Welcome to the InstaliShield Wizard for Sony
DPP-EX5/EXT

The Selup will start the Sony DFP-EXB/EXT instaliation
Maks  the Sony DPP-EX/EX? is disconnect ted
from puter

Installation continues. When it is
completed, the setup compete dialog
box is displayed.

Ul

CI |Ck M Fl niSh " InstaliShield Wizard

6 Remove the CD-ROM from
your computer.

7 Turn on the printer and then
connect the USB connectors of
the printer and your computer.

=

Make sure to turn on your printer before connection.

Click [Finish] and then connect the Sony DPP-EXS/EXT to
your compute,

8 Follow the instructions on the screen to set up the printer
depending on the operating system you use.
The printer will be automatically set up.

o If you cancel the installation midway, do the installation procedures from the step 3.

o If the installation fails, remove the printer from your computer, restart your
computer, and then do the installation procedures from the step 3.

e After installation, the “Sony DPP-EX7” is not set as the default printer. Set the printer
you use for each application.

® The supplied CD-ROM will be required when you re-install or uninstall the printer
driver. Keep it in good order for possible future use.

e Before you use the printer, read the Readme file (the Readme folder of the CD-
ROM-=English folder®Readme.txt).
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To check the installation

Open the “Printers and Faxes”
(Windows XP Home Edition/XP
Professional only) or “Printers” from
the “Control Panel”. When the “Sony

DPP-EX7” is displayed in the “Printers
and Faxes” or “Printers” window, the

DPP-EX7 has successfully installed.

When using the Windows Me

B Printers and Feoas
Fle Edt Yew Foodes Tk Wep

€] > R AP =L Folders
fcch s 3 Privters and Paves

Prines Tasks &

Other Places =

The “Add New Hardware Wizard” may be displayed during installation. If
this occurs, follow the following procedures to proceed with installation:

(@ Check “Automatic search for a better
driver” and then click “Next”. Insert
the supplied CD-ROM into the CD-

ROM drive of your computer.

The dialog box to select the driver
language is displayed.

® Click the language of the driver you
need to install, and then click “OK”.

® Click “Finish”.

(® Remove the supplied CD-ROM from
the CD-ROM drive of your computer.

Add New Hardware Wizard

Windows has found the following new hardware:
Sony DPPEXT

“Windaws can automalicaly search for and instal software

that supports your hardware |f your hardware: came vith

installation media, insert it how and click Nest,

afhat would vou ke ot

1= Biltomatlc searchfar 3 better chiver [Hecommendedt

1 Specily the eeaon o TRe dmver [Rdvanced)

ozt @ Wet> ) Cancel |

‘Wirrdows s found more than cne dives sk may verk for your harnare, Please select fhe diver the
maiches your language and device.

T g
GADRNVER\EYRLISHUWINSE_ MENDFPEAUSE INF 5 2200
W{ND‘I\MN% WE\DPPERUSE INF 5122002
FIVERAGE RMANAWINGE_MENDEPEAUISE INF 52202
(Sony DPP-EX Seses U, GADAINERJAPANESE VwINSE_ME\DPPERLISE INF S1zame
Sesmr L. 6D MENDFPEXLISE INF 51220
C 1) o

Add New Hardware Wizard

E Sony DPP-EX Series USB Digital Photo Printer

Windows has finished installing the scftware you selected
that vour new hardware device requires.

ook ([CFrish ) Cencel

Continued

J9Indwod unoA wouy bunuiid

69 GB



Using your printer with Windows computers

Uninstalling the software

When the software becomes unnecessary, remove the software from your
computer’s hard disk as follows:

1 Disconnect the USB cable from your printer and the computer.

2 Open the “Printers and Faxes” (Windows XP Home Edition/XP
Professional only) or “Printers” from the “Control Panel”.

3 Right-click on “Sony DPP-EX7" in the “Printers and Faxes” or
"Printers” window and select “Delete” from the short-cut
menu.

The confirmation dialog box is displayed.

4 Click “Yes".

The relevant files are removed from your computer’s hard disk.

Printing from an application software
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You can use the “Print “command of an application software to print an image
from your computer with the Digital Photo Printer DPP-EX7.

When using the Windows XP Home Edition/Professional, you can use My
Pictures to print an image (page 73).

¢ Before printing, make sure to connect the USB connectors of the printer and the
computer. If you connect it after you start printing, the printer or the computer
may not work properly.

¢ This section explains the settings and operations with a typical application as an
example. Depending on the application, print settings and operations may differ.
For the details, refer to the manual of your application.

¢ The dialog boxes in this section are those in Windows XP Professional. They may
differ depending on the operation system.

* To obtain the expected print performances, we suggest you use an application
software that allows you to check the print preview. Use the application software to
make the image size to 1644 x 2466 (dots) for the Post Card (4 x 6 inch) size, 1464 x
2064 (dots) for the 3.5 x 5 inch size, and 1137 x 1516 (dots) for the Small (3.5 x 4 inch)
size. Also make the resolution to 403 dpi. Even after these adjustments, an image
may be cut off or proper printed performances may not be obtained depending on
the application software you use. If this occurs, adjust the image size smaller.



1

2

Start the application software that you use for printing, and
select the image to be printed.

Click “Page Setup” from the “File” menu of the application.
The “Page Setup” dialog box appears.

Set the printer.

The dialog box differs depending on ~ [4<% p ]
the application. s
@ Click “Printer” . fm P“:jmm m
The “Page Setup” dialog box is Cwu e on | e on
displayed. F S s e
s | [ @t [t
[ ¥stizal Oftw

=1

® Select “Sony DPP-EX7” as the

Pape Setup

name of the printer. it
. . Hame: C Properties.. )
® Click “Properties”. N —
atus:  Ready
. Tupe: Sany DPP-EXT

The document properties e tenton

window is displayed. Fomment
® Inthe “Layout” tab, select the & Sony DPP-EX7 Document Properties

Orientation of an image either Lt [Poper Ty

y” Orientation

from “Portrait” to print it in [ o
portrait (tall) format or -
“Landscape” to print it in ®
landscape (wide).

®

=a)

Continued
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Using your printer with Windows computers
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® Click “Paper Type” tab and then

set the paper according to the
print paper size you would like
to use for printing.

€ Sony DPP-EX7 Document Properties

Layout | Paper Type |

Paper Type
@ Post card
O35 inch
O Small

margin
= Ovwith border
@ horderiess

Paper Type Select the paper size either from “Post card”, “3.5 x 5
inch” or “Small” according to the print paper size you
use.

margin When you select “Post card” or “3.5 x 5 inch” as the

paper, select the print margin either from “with border”
or “borderless”. (When you select “Small” paper, you
cannot select borderless print.)

® Click the “Layout” tab again and
click “Advanced” in the dialog
box in step ®.
The advanced options window is
displayed.

@ Set the printer in details:

Sony DPP-EXT Advanced Options. EI@

g Sony DPP-EXS Advanced DocLment Settings
=12 Paper/output
Copy Counk: 1 Copy
=[] Graphic
Prink Quality: 403 dpi
= Document ptions
OverCoat:
=5 Color Correc
R 100
G 100
B: 100
Density: 0
Sharp: 0

OverCoat
“Texture”.

You can select finish from either “Glossy” or

Color Correction You can set color tones, density and sharpness levels.

4 Click "OK".




5 Click “Print” from the “File”

General |

menu of the application. S~
The “Print” dialog box appears. ]
6 Set the print range and copies.

S, Foay Demtoge

Lacation:

mmmmm

Nurber of opies
Colale @

e

Page Range In “Pages” text box, enter the page numbers to start
and end printing. To print all the pages, select “All”.
To print the current page, select “Current Page”.

Number of copies Enter the number of copies to be printed.

Cancel Stops printing.

7 Click “Print”.
The printer starts printing. The DPP-EX7 printer monitor is displayed
showing the printing process.

To print from My Pictures (when using the Windows XP Home
Edition/Professional only)

1 Insert the images that you want to print into “My Pictures”.
2 Select “My Pictures” from the “Start” menu.
The “My Pictures” window is displayed.

3 Select the folder that you want to
print and then click “Print this
picture”.

The photo printing wizard is
displayed.

Continued
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Using your printer with Windows computers
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4 Click "Next".

The picture selection window is
displayed.

5 Check the images that you want to

print and then click “Next”.

Please remove the checks for the

images that you do not want to print.

Select “DPP-EX7" as the printer you
use and then click “Printing
Preferences”.

The document properties window in
step ®@in page 71 is displayed.

Set the layout , paper type and the
printer details in the same way as in
the steps @ through @ on pages 71
and 72.

Click “OK".

The photo printing wizard is
displayed again.

Click “Next".

Select the layout and print quantity
and then click “Next”.

Welcome to the Photo Printing Wizard

el you foemat are print phorgraphe hom 1 gt

camens o1 roae

Yeu i iz 1o perd phatogagis of iher byoes of
images duecih hom s compuie

Tio eoniman, ehek: e

& Phot Printing Wizard

Pictiae Selection
Pichies: v check: madks villbe pinded Topert ol ichuses. cick Select Al

& Photo Printing Wizard

prenr—
Seloct the pinter snd paper wou want o s
\\\\\
I -
P st pinting. To veinct paper. cick,
Prinkng Prefersnca:
T

B Photo Printing Wizard

Layorst Sulect
Selact & layout iem the choices el

Avsinbls apouts

Full Page Prints

g
th )
Fullpage phoio pok

Huapber of tives b use pach pichre: |1

oo ) pet> ] [Comal ]




& Phote Printing Wizard

The data is transferred to the printer p——

Th vz seeafing yous pichaes S the i

for printing. To stop printing, click
“Cancel Printing”.

Pantngpags 1 2 1.

10When the completing photo printing
wizard dialog box is displayed, click
“Finish".

To stop printing

When a “printing” dialog box is on the screen
Click the “Stop” button or the “Cancel” button.
The printing job is canceled and the dialog box is closed.

When the data has already transferred to the printer queue

1 Open the “Printers and Faxes” (Windows XP Home Edition/XP
Professional only) or “Printers” from the “Control Panel”.

2 Double-click the “Sony DPP-EX7" icon.
The “Sony DPP-EX7” window is displayed. In the window, the
documents in the queue for printing are listed.

3 Click the document you want to stop printing.

4 Click “Stop” or “Cancel” from the “Document” menu.

The document is removed from the list and the printing job is canceled.

For the details, refer to the Windows documentation.

If printing has already started and the print paper has already been loaded, do not
cancel printing. Paper jam may occur. Please wait until the printing is completed.
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Using your printer with Macintosh computers

The supplied DPP-EX7 printer driver enables you to print an image stored on
your computer with the Digital Photo Printer DPP-EX7. To print an image
from the computer, you need commercially available printing application
software.

System requirements

To use the supplied software, you need a Macintosh computer that meets the
following system requirements.

0OS: Mac 0S 8.6/9.0/9.1/9.2/X (v10.1/v10.2) should be pre-
installed.

Port: A USB port should be installed as standard.

RAM: 128 MB or more is recommended.

Hard disk space: 100 MB or more is recommended. (It differs depending
on the number of copies to be printed.)

Drive: CD-ROM drive (for software installation)

* We cannot guarantee the printer operations when a hub is used or when two or more
USB devices are connected to your computer.

e If you connect more than one DPP-SV88/SV77/SV55/MP1/EX7 /EX5 printer at the
same time, you cannot operate the printer.

* You cannot operate the printer from another USB device being used simultaneously.

* Do not remove or connect the USB cable from or into the printer during the data
communication or printing. The printer may not work properly.

* We cannot guarantee operations with all the personal computers with the system
requirements.
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Using your printer with Macintosh computers

Installing the printer driver

When using Mac OS 8.6/9.0/9.1/9.2

1
2

Make sure that the printer is not connected to the computer.

Turn on and start your Macintosh.

Be sure to close all running programs before installing the software.

Insert the supplied CD-ROM into the CD-ROM drive of your

computer.

Double-click the “Mac OS 8.6-
9.x" folder.

Select the software language
by double-clicking the
corresponding folder.

The selected language folder opens.

Double-click “"DPP-EX5_EX7
Installer”.

Click "Install”.

Installation starts. When the
installation is completed, the dialog
box to notify the successful
installation is displayed.

O == (9 IrP-EX5_EX] =— 1B

a 3 items, zero K available

[Mac 05 8 .6-9.x Mac 05 101

Operating Instruct ions

ST

[+

5] (3 English

B e 2t o K weilable

\.»w:wm

1PP-EX5_EXT Unisatallar CEnglih)

TPF-EXS_EXT Instatlar (Engiish)

[The printer driver for the SONY DPP-EX5 BT will be instasled.,

Continued
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Using your printer with Macintosh computers

8 Remove the supplied CD-ROM from the CD-ROM drive of your
computer.

o If you cancel the installation midway, do the installation procedures from the step 4.

o If the installation fails, remove the printer from your computer, restart your
computer, and then do the installation procedures from the step 4

¢ The supplied CD-ROM will be required when you re-install or uninstall the printer
driver. Keep it in good order for possible future use.

Uninstalling the printer driver
When the software becomes unnecessary, remove the software as follows: In
step 6, click “Uninstaller”.

When using Mac OS X (v10.1/v10.2)
1 Make sure that the printer is not connected to the computer.

2 Turn on and start your Macintosh.

Be sure to close all running programs before installing the software.

3 Insert the supplied CD-ROM into the CD-ROM drive of your
computer.

4 Double-click the “Mac 0S X 2060 ety o —
v10.1-10.2" folder. - '

Operating Instructions ~ Mac 0 8.6-9.x Mad\QS X v10.1-)4.

5 Double-click ‘@060  [FMacos Xvi0.1-10.2 =1

n D PPEXS_EX7 i pkg " . }( 2 items, Zero KB available

Readme
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Click (@).

L

When you are using Mac OS X (v10.2),
this dialog box will be not displayed.

Enter the name and
password of the computer
administrator, and then
click "OK".

For the name and password,
refer to the computer
administrator.

Click "Continue”.

9 Click the location you install

the driver and then click
"Continue”.

‘8 Insiall SOMY DPP- EX5/EXT Printar Driver

Authorization

You need an Administrator password to
install the software

Chose.

Authenticate

g Installer requires that you type your passphrase.
. =

i

Name: AAA

Password or phrase;

[#) oetaits
@ (cancet ) ok D

‘8 Install SONY DPP-EXS/EXT Printer Driver

‘Welcoma to the SONY DPP-EXS/EXT Printer Driver
@ntroduction

Welcome to the Mac 05
uided through the ste
software.

Program. You will be
sary 10 install this

‘8 Inszall SONY DPP-EXS/EX7 Printar Driver

Select a Destination
@lntroduction Select a destination disk ta install the SONY OPP-EXS/EXT
@Select Destination fruvare

e .o

Continued
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Using your printer with Macintosh computers

‘8 Inszall SONY DPP-EXS/EXT Printer Driver

10 click “Install”. o

Cligk Install ta parfarm 3 basic installation of this

Installation starts. When it is ‘ oftnase packsge
completed, the dialog box to notify

the successful installation is

displayed.

o

If the driver has been previously
installed, the “Upgrade” is displayed
instead of “Install”. To delete the past
installation information, delete “/
Library /Receipts/DPPEX5_EX7.pkg”.

‘e Install SONY DPP-EX5 (EX7 Printas Driver

11 click “Close”. =

The software was successfully installed

12 Remove the supplied CD-ROM
from the CD-ROM drive of your
computer.

o If you cancel the installation midway, do the installation procedures from the step 4.

o If the installation fails, remove the printer from your computer, restart your
computer, and then do the installation procedures from the step 4

¢ The supplied CD-ROM will be required when you re-install or uninstall the printer
driver. Keep it in good order for possible future use.

Uninstalling the printer driver
When the software becomes unnecessary, remove the software as follows:

1 Disconnect the USB cable from your printer and the computer.

2 Open “Print Center”, select “DPP-EX7"” from the printer list and
then click “Delete”.

The “Print Center” is located in the “Utilities” folder of the “Application” folder.
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Printing from an application software

You can use an application software to print images stored in your computer
with the Digital Photo Printer DPP-EX?7.

¢ Before printing, make sure to connect the USB connectors of the printer and the
computer. If you connect it after you start printing, the printer or the computer
may not work properly.

* This section explains the settings and operations with a typical application as an
example. Depending on the application, print settings and operations may differ.
For the details, refer to the manual of your application.

* The dialog boxes in this section are those in Mac OS X (v10.2). They may differ
depending on the operation system.

¢ To obtain the expected print performances, we suggest you use an application
software that allows you to check the print preview. Use the application software to
make the image size to 1644 x 2466 (dots) for the Post Card (4 x 6 inch) size, 1464 x
2064 (dots) for the 3.5 x 5 inch size, and 1137 x 1516 (dots) for the Small (3.5 x 4 inch)
size. Also make the resolution to 403 dpi. Even after these adjustments, an image
may be cut off or proper printed performances may not be obtained depending on
the application software you use. If this occurs, adjust the image size smaller.

1 Connect the printer to your computer and turn on the printer.

In a while, the printer is detected and ready for printing. When the printer
is ready, the “DPP-EX5” is displayed in the printer list of the “Print
Center”.

2 start the application software that you use for printing, and
select the image to be printed.
When using Mac OS 9.x
Open “Chooser” from the Apple menu, click “DPP-EX7”, and then close
the “Chooser”. e :

Settings: | Page Attributes L ]

3 click "Page Setup”

i =H PN ‘ormat for. | =

from the “File” menu Formatfor: (DPE5T____ W9
. . SONY DPP-EX5/EX7

of the application. paper Size: (Postcd T8}

10,16 cm x 15,24 cm

The ”Page Setup" dlalog Orientation:

box appears.
pp Scale: | 100 %

&)

( cancel )

Continued
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Using your printer with Macintosh computers
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4 Choose the print settings.

Settings

Select “Page Attributes”.

Format for

Select “DPP-EX7” from the drop-down list box.

Paper Size

Select either of the following paper size from the drop-

down list box.

® Post card: When you use the Post Card (4 x 6 inch) size
print paper to make a print with borders.

e Post card (borderless): When you use the Post Card
(4 x 6 inch) size print paper to make a print without
border.

® 3.5 x5 inch: When you use the 3.5 x 5 inch size print
paper to make a print with borders.

e 3.5 x 5 inch (borderless): When you use the 3.5 x 5 inch
size print paper to make a print without borders.

e Small: When you use the Small (3.5 x 4 inch) size
print paper to make a print with borders.

5 click “OK”" to close the dialog

box and select
“File” menu.

"Print” from the L st

Presets: | Standard

Copies & Pages [E3)

@ @

The “Print” dialog box appears. e N

6 select the menu from the drop-
down list box and make the

print settings.

Pages: @Al
Ofrom: 1 w1

Menu Item Setting
Copies & Pages  Pages To print all the pages, select “All”. To
print part of the pages, specify the pages to
start and end printing.
Copies  Enter the number of copies to be printed.
Layout Select the layout direction.
General Select OverCoat either from “Glossy” or “Texture”.

Color Correction

You can set color tones, density and sharpness.

Preview

Displays a preview of the image for printing.




7 Click “Print”.

Printing starts. To stop printing, click “Cancel”.

If printing has already started and the print paper has already been loaded, do not
cancel printing. Paper jam may occur. Please wait until the printing is completed.

When an error occurs during printing in the Mac OS X (v10.1/v10.2)

If an error occurs, follow the procedures.

1

If the right dialog box is
displayed, click “Show
Printer”.

The error description is displayed.

When you are using Mac OS X (v10.1),
click “Show Queue”.

e To stop printing: Click
“Delete Job".

e To resume printing: Click
“Stop Job".

When you select “Stop Job”, the
following dialog box is displayed.

Remove the error and select
the job from the list box and
then click “Resume”.

When you are using Mac OS X (v10.1),
click “Retry”.

Printer Error
An Error Occurred while Printing

Show Printer E

No print cartridge inside. Set the print cartridge for
“Post card” size.

=

{ Delete job )

‘86086 DPP-EXT =

Delete Q Stop Jobs
.. Nojob printing

Status & Name

Hold Untitled

83 GB
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Additional information

Precautions

On safety

® Operate the printer on 120 V AC, 60
Hz (for the 120V area) or 220 to 240 V
AC, 50/60 Hz (for the models for
other areas) only.

* Be careful not to set or drop any
heavy objects on the power cord, or
to damage the power cord in any
way. Never operate this printer with
a damaged power cord.

¢ Should any solid object or liquid fall
into the cabinet, unplug the printer
and have it checked by qualified
personnel before operating it any
further.

¢ Never disassemble the printer.

¢ To disconnect the power cord, pull it
out by the plug. Never pull the
power cord itself.

* When the printer is not going to be
used for an extended period of time,
disconnect the power cord from the
wall outlet.

* Do not handle the printer roughly.

e To reduce the risk of electrical shock,
always unplug the printer from the
electrical outlet before cleaning and
servicing the printer.

¢ Take care not to scratch or damage
your printer’s LCD screen. Always
use the supplied stylus or a plastic-
tipped pointer to tap on the screen.
Do not use a real pen, pencil, or
other sharp object on the screen.

* Your printer’s screen is made of
glass. Do not drop or submit your
printer to external shock.

84 o

On installation
* Avoid placing the printer in a
location subject to:

— vibration

— high humidity

— excessive dust

— direct sunlight

— extremely high or low
temperatures

¢ Do not use electrical equipment near
the printer. The printer will not work
properly in electromagnetic fields.

e The printer is designed to operate
horizontally. Never attempt to
operate the printer in a tilted
position.

* Do not place heavy objects on the
printer.

e Leave enough room around the
printer so that the ventilation holes
are not blocked. Blocking these holes
may cause internal heat build-up.



On moisture condensation

If the printer is brought directly from a
cold location to a warm location or
placed in an extremely warm or humid
room, moisture may condense inside the
unit. In such cases the printer will
probably not work properly and may
even develop a fault if you persist in
using it. If moisture condensation
occurs, turn off the power and do not
use the printer for at least one hour.

On transport

When you transport the printer, remove
the print cartridge, paper tray, the
“Memory Stick” or PC card from the
printer and put the printer and its
peripherals in the original box with the
protective packaging.

If you no longer have the original box
and packing parts, use similar packing
material so that the printer will not be
damaged while being transported.

On cleaning

Clean the cabinet, panel and controls
with a soft dry cloth, or a soft cloth
lightly moistened with a mild detergent
solution. Do not use any type of solvent,
such as alcohol or benzine, which may
damage the finish.

On cleaning of the LCD display, please
see page 12.

On restrictions on duplication

If duplicating documents with the

printer, pay special attention to the

following;:

e Duplication of banknotes, coins, or
securities is against the law.

Duplication of blank certificates,
licenses, passports, private securities,
or unused postal stamps is also
against the law.

TV program, films, video tapes,
others’ portraits or other materials
may be copyrighted. Unauthorized
video printing of such materials may
infringe the provisions of the
copyright law.

85 GB
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About the “Memory Stick”

What is “Memory Stick”?

“Memory Stick” is small, light-
weighted, and next-generation IC
storage media with a larger capacity
than a floppy disc. You can use the
“Memory Stick” to exchange data
among “Memory Stick” compatible
devices. In addition, you can use the

“Memory Stick” as a removable external

storage device to save your data.

Types of “Memory Stick”

Following types of “Memory Stick” are
available for versatile purposes.

e “Memory Stick”: “Memory Stick”
can store all types of data except for
the one that requires the
“MagicGate” copyright protection
technology.

e “Memory Stick (with memory

select function)”: “Memory Stick

(with memory select function)”

incorporates multiple 128MB

memory units, which can be selected
by a user via a mechanical switch on
the reverse side of the media. Each
memory unit can be used to
categorize various types of data.

You cannot select multiple memory

units together or continuously.

“MagicGate Memory Stick” :

“MagicGate Memory Stick ”

employs the “MagicGate” copyright

protection technology.

86 GB

* “Memory Stick PRO” : “Memory
Stick PRO” employs the
“MagicGate” copyright protection
technology and can be used only
with “Memory Stick PRO” compliant
devices.

* “Memory Stick-ROM": “Memory
Stick-ROM” is the read-only
“Memory Stick” storing the data.
You cannot save or delete its data.

On “Memory Stick Duo”

“Memory Stick Duo” is smaller than the
standard-sized “Memory Stick”. When
inserted into the Memory Stick Duo
adaptor, the “Memory Stick Duo” is the
same size as the standard-sized
“Memory Stick”, and can be used with
“Memory Stick” compliant devices.

* When using the “Memory Stick Duo”
on the printer, make sure to insert
the “Memory Stick Duo” into the
Memory Stick Duo adaptor and then
insert the adaptor containing the
“Memory Stick Duo” into the
printer.

¢ Before using the “Memory Stick
Duo”, check the correct direction to
insert the “Memory Stick Duo”. If
you attempt to insert it in a wrong
direction, the “Memory Stick Duo”
and the printer may be damaged.

¢ Never insert the Memory Stick Duo
adaptor that contains no “Memory
Stick Duo” into a “Memory Stick”-
compatible device. If you do, the
device may be damaged.



Types of “Memory Stick”
that the printer can use

With the printer, you can do the
following operations for each type of
“Memory Stick”:

Read Write/Delete/
Format

“Memory Stick”/

“Memory Stick (with ~ OK OK
memory select

function)”/“Memory

Stick Duo”"2

“MagicGate Memory
Stick”/“MagicGate oKl oK'
Memory Stick Duo”"?

“Memory Stick PRO” OKl  OK™

“Memory Stick-ROM” OK NO

*1 The printer cannot read /write the data subject to
“MagicGate” copyright protection.

*2 Use the adaptor designed for the “Memory Stick
Duo” you use.

We cannot guarantee the operations of all the “Memory

Stick” media.

On data read/write speed

The data read /write speed differs
depending on the combination of the
“Memory Stick” and the device you use.

What is “MagicGate"?

“MagicGate” is the copyright protection
technology that works when both the
“Memory Stick” and the device employ
the technology. The “MagicGate”-
compatible device and the “MagicGate
Memory Stick” attest that each other
supports the “MagicGate” technology
and encode the data they exchange.

The printer does not support the
“MagicGate” standards and cannot read
or write the data subject to the
“MagicGate” copyright protection.

Notes on use

* When you slide the write protect
switch to the write protect position,
you cannot record, edit, or delete the
data.

* When you slide the write protect
switch of the “Memory Stick Duo”,
use a thin-pointed device.

Connector
< i Write Write

enable protect

position position

< =
| @D | @D
LOCK =~ LOCK =~

Place the label here
Continued
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About the “Memory Stick”

* Avoid removing the “Memory Stick”
from the printer while the printer is
reading or writing data.

¢ Data may be damaged in such
occasions:

— “Memory Stick” is removed or the
printer is turned off while the
printer is reading or writing the
“Memory Stick” data.

— “Memory Stick is used in a location
subject to electrostatic or electronic
noises.

* We recommend that you save
backup of the important data.
Attach the label designed for the
“Memory Stick” only to the place for
the label.

When attaching the label, attach it to
the place specified for the label.
Make sure that the label does not
overlap.

* When storing and carrying the
“Memory Stick”, keep it in its
original case to ensure protection of
important data.

Avoid touching the connector of the

“Memory Stick” or contacting it with

a metal object.

* Do not drop, bend, or submit the
“Memory Stick” to external shock.

* Do not disassemble or modify the
“Memory Stick”.

* Avoid getting liquids on the

“Memory Stick” or using it in areas

subject to high humidity.

88 GB

* Avoid using or storing the “Memory

Stick” in a location subject to:

— extremely high temperature such as
the hot inside of a car or the
outdoors exposed to direct sunlight,
or a place near a heater.

— direct sunlight

— high humidity

— corrosive substances

When formatting a “Memory Stick”,
use the format function of the printer
or your digital still camera. If you
format a “Memory Stick” with your

computer, images may not be
displayed properly.



About the PC card

The printer can read and write a PC card

(PCMCIA ATA compatible type II flash
memory cards with a power
specification of 5V or 3.3/5V). By using
a commercially available PC card
adaptor, you can also use Smart Media
and other types of compact flash
memory cards.

Notes on use

* You cannot use PC cards with a
power specification of 3V (3.3V)
only.

* Do not insert other types of PC card
into the printer’s insertion slot. The
printer may be damaged.

¢ Do not drop, bend, or submit the PC
card to external shock.

e Do not disassemble or modify the PC
card.

Avoid getting liquids on the PC card
or using them in areas subject to high
humidity. Otherwise, data may be
rendered unreadable.

* Avoid using or storing the PC card

in a location subject to:

— extremely high temperature such as
the hot inside of a car or the
outdoors exposed to a direct
sunlight, or a place near a heater.

— direct sunlight

— high humidity

— corrosive substances

— excessive dust

— electrostatic or electronic noises

— magnetic fields

® When storing and carrying the PC
card, keep it in its original case to
ensure protection of important data.

* Avoid removing the PC card from
the insertion slot or turning off the
power of the printer while the
printer is accessing the PC card.
Otherwise, data may be rendered
unreadable.

* When using a compact flash card or
Smart Media, use a commercially
available PC card adaptor that is
compatible with the card. Insert the
card into the adaptor and then insert
it into the printer. For how to install
the card and adaptor, refer to the
operating instructions of the PC card
adaptor.

Avoid inserting or removing the
compact flash card or Smart Media
into or out of the PC card adaptor
while the PC card adaptor is inserted
in the printer. The data may be
rendered unreadable or erased.
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Troubleshooting

If you run into any problems using the
printer, use the following guidelines to
solve the problem. If the problem
persists, consult your Sony dealer.
When you are printing from your
computer, also refer to the computer
manual.

Cannot operate the printer after the
power switch is turned on.

= Connect the AC power cord to an
AC outlet securely.

The LCD screen of the printer
displays no images.
< Insert a “Memory Stick” or PC card
securely. Check that images
recorded by a digital still camera or
other device are recorded.

< Make sure that the PC input
indicator is not lit.

= Press the INPUT SELECT button to
turn on the “MEMORY STICK” or
PC CARD indicator.

Cannot print.
< Insert the correct set of print
cartridge and print paper.
< Check that the paper tray has paper.
2 The thermal head may be
overheated. Leave the printer until

the head cools down and the printer
resumes printing.

< Remove the jammed paper, if any.
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An image in the image list is not
properly displayed or printed.
2 If the image is displayed but can not
be printed, the file used for printing
is damaged.

< If the mark shown on
the right is displayed
in the image list, the
image is a JPEG file
created with your
computer, or the
thumbnail data of the
image is damaged.

e

Tap the mark and if a preview
image is displayed, you can print
the image. If the same mark is
displayed again as a preview, the
image is stored in an incompatible
file format that the DPP-EX7 does
not support or the image itself is
damaged.

< An image which is damaged or has
some kind of problem will not
appear in the image list. A file error
message appears. If there are no
images stored in the “Memory
Stick” or PC card, the no file
message appears on the display.

< If an image is not compatible with
DCEF (Design rule for Camera File
system), it may not be printed with
the printer even if it is displayed on
the PC monitor.

< The printer can handle and display
up to 9,999 image files. If there are
more than 9,999 images stored in the
“Memory Stick” or PC card, use the
computer to display and handle the
remaining images.



2 Depending on the type of digital
still camera used, the aspect ratio of
the recorded image differs, so the
image may not be printed covering
the entire printable area.

2 Depending on the type of digital
still camera used, preview images
may be displayed along with the
primary images in the thumbnail
list. The printed quality of the
preview images will not be as good
as the primary images. Note that if
you delete the preview images, the
data for the primary images may be
damaged.

2 Depending on the type of digital
still camera used, the image may be
stretched vertically if it has been
rotated or processed using your
digital still camera. This is not
because of trouble with the printer,
but because the image was rewritten
using your digital still camera.

< Some types of PC card adaptor that
are not compatible with PCMCIA
ATA cannot be used with this
printer.

< When you name or rename an
image file on your computer and its
file name includes characters other
than alphanumeric characters, the
file name may not be displayed
correctly or the image may not be
displayed (read error) on the
printer.

The beeps sound.
< Check that you are following the
correct procedures.

Cannot remove the print cartridge.
2 Turn the printer off then on. After
the motor sound stops, try to
remove the cartridge.

If this does not solve the problem,
contact Sony service facilities or
your Sony dealer.

The [ or & indicator is lit or an
error message is displayed.
= Follow the instructions on the
screen.

There is a white line or dots in the
printed pictures.
< The print head or paper path may
be soiled. Use the supplied cleaning
kit to clean the head and path (page
92).

Continued
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Troubleshooting

If paper jams

If the print paper jams, the [ paper error indicator lights and an error
message is displayed. Printing stops. Turn the printer off and remove the
jammed paper from the paper outlet or take out the paper tray to remove the
jammed paper.

Take out the paper tray
to remove the jammed

jammed paper
slowly.

If you cannot remove the jammed paper, contact your Sony dealer.

Cleaning the inside of the printer

If white lines or dots are printed on the pictures, use the supplied cleaning
cartridge and paper to clean inside the printer.

*Make cleaning only when there are white lines or dots on the print.

® When you can obtain proper printing performances, cleaning will not improve the
printed picture quality.

e With the supplied cleaning kit, you can make cleaning for the maximum of about 20
times. As the number of cleaning times increases, the cleaning paper loses its
cleaning effect.

* Do not place the cleaning paper on the print paper, which may cause paper jam or
other troubles.

¢ If a cleaning does not improve printed picture quality, please make cleaning a
couple of times.

* You can also make cleaning with the protective sheet contained in the printing pack
designed for the DPP-EX7. To use the protective sheet for cleaning, insert the paper
with its imprint surface facing down into the tray.
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Open the cartridge compartment lid and remove the print
cartridge (page 18).

Insert the supplied
cleaning cartridge (white)
into the printer and close
the cartridge compartment
lid.

Remove the paper tray from the printer. If there is print paper
in the tray, remove the print paper from the tray.

Remove the 3.5 x 5 inch
paper adaptor and stand
the partition up. Place
the supplied cleaning
paper with the no-imprint
side facing up and the

arrow pointing in the Arrows in
: : the reverse
same direction as the side

arrow in the tray. Insert Partition
the paper behind the
partition.

Set the paper tray into the printer and press the PRINT button.

The cleaning cartridge and cleaning paper will clean inside the printer.
After the cleaning is finished, the cleaning paper is automatically ejected.

Remove the cleaning cartridge and cleaning paper from the
printer and set the print cartridge and print paper.

Keep the cleaning cartridge and cleaning paper together. With a sheet of
cleaning paper, you can make cleaning for the maximum of about 20
times.

93 GB
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Specifications

Printing method

Dye sublimation printing (Yellow/
Magenta/Cyan 3 pass)

Resolution
403 (H) x 403 (V) dpi
Image processing per dot
256 levels (8 bits for each Yellow /
Magenta/Cyan), approx. 16,770,000 colors
Printing size
Post Card (4 x 6 inch) size:

101.6 x 152.4 mm (maximum,
borderless)

3.5 x 5 inch size:
89 x 127 mm (maximum, borderless)
Small (3.5 x 4 inch) size:
71.7 x 95.5 mm (maximum)
Printing time (per sheet)
Post Card (4 x 6 inch) size:
approx. 90 seconds

3.5 x5 inch size:
approx. 75 seconds

Small (3.5 x 4 inch) size:
approx. 60 seconds

(excluding the time for data processing
and data transferring from the personal
computer or “Memory Stick” or PC card)

Input/output connectors
USB connector (1)
Slot

“Memory Stick” insertion slot (1)
PC card insertion slot (PCMCIA 1I) (1)

94 8

Compatible image file formats*!

DCF2: Exif Ver. 2.1/2.27,
JPEG compatible, TIFF*-RGB (non-
compressed)

JPEG: 4:4:4, 4:2:2, 4:2:0 (baseline JPEG)
BMP: 24 bits full color, Windows format
JFIF
(Note that some versions of the file
formats may not be compatible.)
Recording image format
DCF compatible: Exif ver. 2.2, JPEG

compatible

Maximum number of pixels to be
handled

JPEG:  6,400(H) x 4,800(V)
BMP:  5,400(H) x 4,050(V)
TIFF:  4,800(H) x 3,600(V)
Maximum number of files to be handled

9999 files per a “Memory Stick” or PC
card media

Print cartridge/Print Paper

See “Preparing the printing pack” on
page 17.

LCD display
3.8 inch transparent STN color display
320 x 240 x RGB

Power requirements

120V AC,60Hz, 1.12 A
(for the 120 V areas)

220 -240 V AC, 50/60 Hz, 0.6A
(for 220 to 240 V areas)

Power consumption (standby mode)

Approximately 1 W



Operating temperature *1:  Some special file types are not
5°C to 35 °C (41 °F to 95 °F) compatible.
*2:  “DCF” stands for Design rule for
Dimensions Camera File system.
Approx. 242 x 87 x 267 mm *3:  “Exif” is an image file format containing

an image data added with its thumbnail
data for viewing, shot date data and the
shooting conditions data.

(w/h/d, excluding protruding parts)
(9°/, x31/,x10%/,inches)

3 s
(i63 mm (14 /§ 1{1che;) of depth when *4:  The printer functions may be limited for
the paper tray is installed.) a TIFF file.

Mass

Approx. 2.4 kg (51b 5 0z)
(excluding the 0.1 kg (4 oz) paper tray)

Supplied accessories

See “Unpacking the printer” on page 8.

Design and specifications are subject to
change without notice.

Customer support home page
The latest support information is available at the following homepage
addresses:

For the customers in the U.S.A.:
http:/ /www.sel.sony.com/SEL/service/conselec/
For the customers in Canada:
http:/ /www.sony.ca/service
For the customers in Europe:
http:/ /www.sony-imaging.com/support
For the customers in Singapore:

http:/ /www.css.ap.sony.com
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Glossary

Auto Fine Print 2

The function automatically corrects
the picture quality so that an image
may be printed in more vivid, clear
and beautiful pictures. Itis
especially effective for a darker
image with low contrast. The
pictures are corrected to reproduce
natural skin colors, vivid tree leaf
green, or clear sky blue.

DCF (Design rule for Camera File

system)
The standard specified by JEIDA
(Japan Electronic Industry
Development Association) to
maintain the file exchangeability and
compatibilities between digital still
cameras and related products.

DPOF (Digital Print Order Format)

The format used to record the
information necessary for
automatically printing images shot
by a digital still camera at a printing
shop or with a home-use printer. The
printer supports DPOF printing and
can automatically print the preset
number of copies of the DPOF preset
images.

96 GB

Exif 2.2 (Exif Print)

Exif (Exchangeable image file format
for digital still cameras) Printis a
global standard for digital photo
printing. A digital still camera
supporting Exif Print stores the data
relevant to the conditions of shooting
as each shot is taken. The printer
utilises the Exif Print data stored in
each image file to ensure the printed
result matches the original shot as
closely as possible™.
*1 When the “Auto Fine Print 2” is
enabled and an image (JPEG file) is
shot by an Exif Print (Exif 2.2)-
compatible digital still camera, the
image is automatically adjusted to its
optimum picture quality and printed.

“Memory Stick”

A next-generation, compact, light,
removable storage media used with
a digital still camera, video camera,
or PC. In its compact body, it can
record a larger volume of data than a
floppy disc can. You can use it to
exchange data among “Memory
Stick” ready devices and also use it
as removable and external storage
medium.

Thumbnails

Miniature images for representing
the original images that are stored in
the image files taken by a digital still
camera. The printer uses thumbnails
in the image list.



Index

Symbols
3.5 x5 inch size 17

A

AC power cord 15
Adjusting the image
position and size 32, 40
ALL/DPOF 28

Auto Fine Print 2 58, 96

B
Beep 61

Border/Borderless print
59

C
Calendar 41, 42

Canceling the selection
25

Card 38

Cartridge compartment
lid 18

Cartridge error indicator
18

Cleaning the printer 92
Clock setting 61
Color Setting 60
Connecting
AC power cord 15
Computer 16
Creative Print menu 36

Cursor 23
Cut out tool 54

D

Date Print 59

DCF 96

Deleting images 64
Displaying another page

DPOF 28, 96
Dragging 13

E
Edit 32
Effect menu 30

Entering a message
39, 51

Entering characters 50
Exif Print 6, 96

F
Features 6
Filter 35

Formatting the “Memory
Stick” 65

G
Glossy 59

|

Index Print 46

INPUT SELECT 16, 23

Installing the software
Macintosh 77
Windows 67

L
LCD display contrast 62

M
“Memory Stick”
Inserting/removing 14
Notes on use 89
Usable types 86
Write protection 89
Menu screen 57
Message tool 55

Moisture condensation
85

o)
Operation panel 12

Options 61

P

Paper error indicator

22, 92

Paper jams 92

Paper tray 10, 20

PC Card
Inserting/removing 15
Note on use 89

Pencil tool 49

Post Card size 17

POWER button

18, 23, 25, 28
Preview image 24
PRINT button 24, 26
Print cartridge 17, 18
Print mark 28

Print paper 17, 20
Print Setting 58

Continued
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Index

Printing
All or DPOF images 28
an image 23
Calendar 41
Cards 38
From a Macintosh
computer 81
From a Windows
computer 70
Index prints 46
Multiple images 25
Split images 43
Sticker 44

Printing pack 17

Printing surface 21
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S
Saving an image 31, 37

Selecting an image
25, 39

Setting the calendar 42

Setting the print quantity

26

Slide Show 63

Small size 17

Specifications 94

Split Images 43

Stamp tool 53

Sticker 44

Stylus 13

Supplied accessories 8

System requirements
Macintosh 76
Windows 66

T
Tapping 13
Template 38
Texture 59
Thumbnails 90, 96
Tool 48
Troubleshooting 90
Type tool 50

U

Uninstalling the software
70, 78, 80
USB connector 16



Printed on 70% recycled paper.
Sony Corporation  Printed in Japan http://www.sony.net/
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